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Blender é hoje uma realidade palpável dentro do universo de softwares voltados 
para computação gráfica tridimensional. São tantos os seus recursos que é difícil 
enumerá-los qualitativa e quantitativamente. Seus módulos permitem elaborar 

complexas modelagens e avançadas animações, e como se isso já não fosse suficiente, 
Ton Rosendaal, seu criador, ainda dotou o software de um elegante editor de vídeos e de 
uma poderosa game engine.  
 
Tudo isso a custo zero para o usuário final, pois trata-se de uma ferramenta licenciada 
como Software Livre. Ou melhor: exige-se esforço para o aprendizado de uma interface, 
que, se não é difícil, é no mínimo bastante exótica dentro dos parâmetros que 
conhecemos, advindos do uso constante de softwares da Adobe, Corel e Microsoft. 
 
A game engine do Blender, por exemplo, já começa a ser utilizada industrialmente como 
alternativa atraente para a produção de jogos tridimensionais. Seu uso não é tão 
complexo e seus recursos não deixam a desejar. A utilização de física, dinâmica de 
fluídos, e soft bodies também tornam a ferramenta ideal para a aplicação em animações 
e comerciais publicitários complexos. 
 
Mas os designers pouco têm percebido o potencial desta ferramenta para a elaboração de 
modelos tridimensionais, e até sua aplicação em design gráfico. E é esse o objetivo deste 
simples e despretensioso guia, abrir sua mente para as possibilidades do uso desse 
singelo, porém poderoso, recurso disponível a todos que tenham a iniciativa de arregaçar 
às mangas e aprender. Mostraremos o uso do Blender 3D aplicado em projetos simples 
orientados a design e comunicação visual. Espero que consiga, senão completamente, ao 
menos essencialmente, suprir suas necessidades na elaboração de seus trabalhos 
práticos. 
 
Desejo uma boa sorte em sua incursão neste novo mundo que se abre promissor. 
 
Bruno Maia de Andrade

O 
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1.1Softwares Proprietários para design 
 

objetivo desde guia é mostrar como o futuro designer, ou mesmo aquele que já 
exerce sua atividade, poderá lidar com situações complicadas em relação a 
aquisição de softwares como ferramentas para concepção e resolução de 

problemas em design, seja ele gráfico, de produto, ou web design, e prover 
conhecimentos  em soluções inteligentes baseadas em Software 
 Livre, que funcionem como alternativa a aplicativos proprietários, e assim contornar 
algumas dessas situações indesejadas..     
 
Entenda como software o conjunto de instruções que serão executadas por um 
computador e seus circuitos, fornecendo ao usuário uma interface de comunicação, ou 
não.  
 
Geralmente, instruções não requisitadas pelo usuário operam autonomamente em 
linguagem de máquina e são softwares de sistemas, como drivers de dispositivos, 
firmwares e BIOS. O sistema operacional de um computador, como o Windows ou Linux, 
é um software de sistema que oferece uma interface gráfica de usuário, uma GUI 
(Graphic User Interface) que pode ser manipulada, de maneira limitada, através de 
dispositivos de entrada de dados, como mouses e teclados. 
 

 
O tipo de software que nos interessará, será o Software de aplicativo, que permite ao 
usuário realizar tarefas específicas de acordo com suas capacidades e funções 
cotidianas desempenhadas. Um exemplo é o Microsoft Office (fig.02), uma suíte de 
automação de escritório, brutalmente utilizada, seja para redigir um texto, uma simples 
planilha de cálculo, com os custos mensais de sua casa ou ainda uma apresentação 
para um seminário acadêmico ou profissional, num documento de Power Point. 

O 

Figura 1- Exemplo de GUI de um Software de 
sistema:Windows Vista. 
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Esse tipo de aplicativo não é essencial para o funcionamento do computador, ele serve 
exatamente para dá função prática a ele, facilitando a nossa vida. Na maioria das vezes 
é vendido em pacotes, pela Internet, em caixas de papelão, no Supermercado, ou em 
versões mais antigas, distribuídas em revistas com CD-ROM's ou DVD's com preços 
mais módicos. Eles são protegidos por leis internacionais de propriedade intelectual, e 
em alguns países, como os EUA, têm seus códigos patenteados por lei. Ou seja, 
quando você instala um aplicativo como o Corel Draw, por exemplo, precisa aceitar um 
contrato de licenciamento entre você e o fornecedor, esse contrato, muitas vezes, 
aparece em uma tela durante o processo de instalação e chama-se EULA(End User 
License Agreement ), clicando em algo como “Concordo com os termos de 
licenciamento”,o usuário prossegue com a instalação de seu aplicativo. 
 
O grande problema é que esses Softwares de Aplicativos constituem ferramentas 
indispensáveis para a realização de nossas tarefas cotidianas nos dias de hoje e custam 
uma fortuna, além de terem termos de utilização espartanos, permitindo sua utilização 
em apenas um computador, na maioria das vezes.  
 
O designer, há tempos, quase abandonou os meios analógicos de concepção, e passou 
a produzir utilizando as tipografias fornecidas pela máquina, as modelagens 
tridimensionais, os efeitos automatizados, enfim, hoje se utiliza Softwares gráficos para 
praticamente toda a fase projetual de desenho industrial. 
 
Com o “boom” da informatização de empresas e lares, ocorrido nos anos 90 e mais 
incisivamente nos 2000,  surgiu uma oferta muito grande dessas soluções. O fato é que, 
até 1990 ou 1991, nunca se acreditou que software pudesse ser vendido por preços 
altos e assim enriquecer muitos empresários do setor. A exceção, foram as empresas 
que hoje ditam as regras do mercado, como a Adobe, a Corel, a Autodesk e a própria 
Microsoft. Empresas de nossa área de atuação, como a Apple, ou Silicon Graphics, não 
vendiam software propriamente dito, mas sim soluções prontas, que envolviam o 
hardware, “aquilo que você chuta” (Sérgio Amadeu, 2003), e o Software, “Aquilo que 
você xinga quando trava”. 
 
Todo esse processo de ascensão das corporações pioneiras, ocorrido na década 
passada, serviu para prover o mundo moderno de uma informatização prática, fácil, 
moderna e de segurança contestável, que embora seja muito mais barata e eficiente que 
os métodos analógicos, ainda é muito cara se levarmos em conta as leis do mercado, 
simplesmente porque estamos falando de um produto que rende retorno de 80% para o 
fornecedor, segundo pesquisas, algo impossível em outros setores de produção. 
 

Figura 2- Microsoft Office 2003 Figura 3- Corel Draw X3 
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Outro problema foi o surgimento de monopólios, como o da Microsoft, nos anos 90, com 
seu Windows, e mais recentemente o da Adobe, com a fusão ocorrida em 2004, com a 
Macromedia, ex-produtora do Flash. Monopólios são péssimos para o consumidor final, 
porque tornam as empresas acomodadas, limitam a criatividade, a competição e geram 
preços muito altos para o usuário, além disso tornam o consumidor “preguiçoso”, 
dependente daquele fornecedor específico para exercer sua atividade.  
 
Em informática isso tem um valor ainda mais significativo, visto que a área é dita de 
difícil assimilação por leigos, o que complica ainda mais possíveis adoções de soluções 
diferentes. Por exemplo, usuários do Corel Draw, não querem aprender Ilustrator, pois é 
um novo conceito, de complexidade diferente. Há também uma “padronização”, não 
normatizada pela ISO ou ABNT, por parte do mercado, em cima de soluções clássicas 
solidificadas, como o Corel Draw, o Photoshop e o 3D Max, que já viraram mantras em 
requisitos para estágios e empregos no setor de comunicação visual. Com isso, o 
estudante tende a obter cópias não-licenciadas, de aplicativos que chegam a custar até 
R$10.000,00, pagando para cambistas e fornecedores ilegais, quantias irrisórias de 
R$20,00 ou R$30,00, temendo ficar de fora do mercado 
 
Tal prática é crime, segundo a  Lei anti-pirataria (10.695 de 01/07/2003),  ou ainda 
segundo a lei 9.610 de 1998, sobre direitos autorais. No entanto, as corporações 
costumam fazer vista grossa para o uso acadêmico, ou pessoal, desses aplicativos 
ilegalmente, devido ao fato desse tipo de utilização acabar atendendo a demanda da 
indústria, essa sim, pagante, funcionando como uma forma de treinamento prévio do 
usuário. 
 
A tabela 1, abaixo, mostra o custo de aquisição dos principais aplicativos gráficos 
propostos para que um  designer desempenhe suas funções sem perda de 
desempenho: 
 
 

Softwares Preços 
MS  Office R$ 1,300.00 
Windows Vista Ultimate Full R$ 799.00 
Corel Draw Graphics Suíte X3 R$ 1,199.00 
Corel Painter X R$ 1,399.00 
Adobe Creative Suite: 
        Indesign CS3  
        Photoshop CS3 Extended  
        Illustrator CS3  
        Acrobat 8 Professional  
        Flash CS3 Professional 
        Dreamweaver CS3 R$ 4,959.00 
After Effects CS3  R$ 3,527.00 
3D studio Max R$ 8,000.00 
Total: R$ 21,183.00 

Tabela 01- Fontes:http://www.brasoftware.com.br/ e http://www.kalunga.com.br  
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Em se tratando de hardware, com R$21.183,00, o montante total das licenças desses 
softwares para instalação em uma única estação, seria possível comprar 15 micro-
computadores com  a seguinte   configuração:  
 

CPU Dual Core E2160 1.8GHz 1GB 250GB DVD-RW  
Linux – Megaware 
Monitor LCD 19'' Widescreen – AOC  
 Preço Individual: R$ 1.399,00  

Tabela02- (Fonte:http://www.americanas.com/AcomProd/590/2495043) .  
 
Ou seja, chegamos ao paradoxo de ter softwares, que muitas vezes obtivemos 
ilegalmente a custo zero pela internet, sendo até 20 vezes mais caros, quando 
comprados originalmente, que os equipamentos, que muitas vezes abrigam muito mais 
tecnologia que os softwares aplicativos. 
 
1.2 Software Livre aplicado a design 
 

Para uma pequena empresa, ou um estudante de designer, comunicação visual, ou 
artes gráficas, é proibitivo e ilusório tentar adquirir as licenças de tantos aplicativos, 
como os citados acima, pelos métodos legais. Sabemos da enorme qualidade de um 
Adobe Photoshop, para tratamento de imagens, ou das múltiplas capacidades de um 
Corel Draw, indo de simples software para desenho vetorial até solução completa para 
diagramação. Mas não podemos nos fechar para uma realidade que existe para  ajudar 
a sanar alguns problemas: O uso de software livre para design e computação gráfica. 
 
Segundo a definição do órgão internacional que gerencia as licenças livres de 
aplicativos de todos os tipos, a Free Software Foundation (FSF), Software Livre é todo 
aquele que propõe 4 liberdades básicas para o usuário: 
 

 
• A liberdade de executar o programa, para qualquer propósito (liberdade nº. 0);  
• A liberdade de estudar como o programa funciona, e adaptá-lo para as suas 

necessidades (liberdade nº. 1). Aceso ao código-fonte é um pré-requisito para 
esta liberdade;  

• A liberdade de redistribuir cópias de modo que você possa ajudar ao seu 
próximo (liberdade nº. 2);  

• A liberdade de aperfeiçoar o programa, e liberar os seus aperfeiçoamentos, 
de modo que toda a comunidade se beneficie (liberdade nº. 3). Acesso ao 
código-fonte é um pré-requisito para esta liberdade.  
 

   Tabela 03- Fonte:www.softwarelivre.org 
 
Entenda por código, a receita que leva ao programa, como o bolo, o software é o bolo e 
o código é a receita, que, no caso da computação, é escrita numa linguagem de 
programação, como C+, Assembly etc. e posteriormente compilada (“cozida”), para  
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gerar o programa (o bolo). No software fechado, você apenas come o bolo, contudo no 
livre você vai a padaria, compra o bolo e recebe a receita do padeiro, caso saiba fazer 
bolos. 
 
Não confunda Software Livre com software grátis, geralmente o segundo é um 
commodity, ou seja, um aplicativo que é dado por uma empresa num mundo de serviços 
pagos para tornar a vida do usuário mais simples, como o Internet Explorer, da 
Microsoft, ele é grátis, porém não livre, e nunca vem com o código fonte, portanto não 
há desenvolvimento colaborativo ao redor do mundo. Você não tem licença para 
redistribuí-lo. 
 
Em um Software Livre é válido o conceito de liberdade, acima de tudo, como promulga o 
criador do conceito, Richard Stallman, em sua licença Livre, GPL (General Public 
License, 1991), e não de gratuidade. A questão não é o preço. Você pode inclusive 
pagar por um software Livre,  pagar por um pacote contendo um kit de aplicativos, e aí 
está incluso o suporte, porém você não é obrigado a tal, e uma vez que pague pode 
redistribuí-lo à vontade. Quando um programa se torna livre, não pode mais ser fechado, 
a não ser em uma nova versão. Entretanto isso é muito raro. 
 
Grandes empresas ganham dinheiro vendendo soluções em Software Livre e pacotes, 
dando suporte e consultoria, exemplos são a IBM, a HP e a própria Apple, cujo sistema 
operacional, o Mac OS X é fortemente estruturado sobre Software Livre. Assim, este tipo 
de aplicativo não é ruim porque é de graça, ele é desenvolvido por programadores ao 
redor do mundo por um sem fim de motivos. Ou porque querem desengessar suas vidas 
num mundo de burocracia, repleto de restrições, ou porque não podem concorrer com 
uma “Microsoft”, e então abrem  o código do programa para que outras pessoas possam 
contribuir, ou porque gostam do que fazem, porque querem ganhar destaque rápido no 
mercado, e nada melhor que ter um programa livre altamente utilizado, como o 
navegador Firefox, para servir de portfólio. O principal é que alguns desses projetos, 
como o Blender 3D, software para modelagem tridimensional, têm um valor humano 
agregado muito grande. São trabalhos de uma vida, e nunca existiriam se pessoas do 
mundo inteiro não contribuíssem, diariamente. Portanto fica difícil imaginar como um 
aplicativo desses não pode ter qualidade, se existe uma motivação maior, que não 
envolve apenas dinheiro. Embora este não seja excluído da equação, sendo 
fundamental. 
 
Quando falamos em Software Livre para Computação gráfica, design e artes gráficas, 
nos referimos a um panteão de aplicativos muito maduros e robustos, rápidos e leves, 
porém pouco utilizados, principalmente devido ao fato de que concorrem com padrões 
“de fato”, como  os da Adobe e da Corel, entretanto é bom lembrar que o que vale num 
trabalho de design é o resultado final, e não os softwares utilizados. Outro quesito que 
conta contra o software livre é que ele é feito para funcionar, portanto não espere helps 
na interface, ou mesmo uma boa interface do usuário, geralmente, eles são brutos, e 
esse é um dos motivos pelos quais as pessoas não gostam muito deles: A má interação 
“homem-máquina”, a popular ergonomia. Assim um dos objetivos desse guia é 
desvendar uma interface aparentemente complicada e mostrar que ela pode ser muito 
útil e produtiva quando bem utilizada. Não tenho nenhuma intenção de incentivar o 
usuário a substituir suas atuais ferramentas de trabalho por outras, a palavra aqui é 
complementar, para que você não fique perdido quando as alternativas se esgotarem. 
 



 14 

Na tabela a seguir eu mostro os principais softwares proprietários e seus 
correspondentes no mundo livre. 
 

Aplicativo Proprietário Software Livre e site 
Adobe Photoshop GIMP (http://www.gimp.org) 
Corel Draw ou Ilustrator Inkscape (http://www.inkscape.org) 
Adobe Indesign Scribus (http://www.scribus.net/) 
3D Studio Max Blender (http://www.blender.org) 
Maya Art of Ilusion (http://artofillusion.org/) 
Rhinoceros Wings 3D (http://www.wings3d.com/) 
Dreamweaver NVU (http://www.nvu.com) 
Pro Tools Audacity 

(http://audacity.sourceforge.net/) 
Ardour (http://ardour.org) 

Adobe Premiere Cinelerra (http://heroinewarrior.com/) 
After Effects Jahshaka (http://jahshaka.org/) 
Flash Ktoon (http://ktoon.toonka.com) 

        Tabela 04- Fonte:http://estudiolivre.org 
 
De especial interesse para nossos estudos, serão o  Inkscape e o Blender esses 2 
aplicativos livres são os mais importantes para nossa área de atuação. Alguns desses 
softwares, como o Ardour, (aplicativo voltado para edição de áudio), são tão poderosos 
quanto seus equivalentes em Windows,  nesse caso, o Pro Tools. Porém só dispõem de 
versões para Linux e Mac OS. 
 

   
 
A maioria desses softwares é licenciado pela licença livre GPL, mantida pela Free 
Software Foundation, contudo existem outras licenças livres, como a LGPL, a BSD 
license, a Creative Commons, ou simplesmente a não-licença. Onde o usuário 
simplesmente doa o conhecimento ao domínio público, como Tim Berners Lee fez com 
seus protocolos para Web. 
Bom agora que conhecemos os conceitos por detrás do Software Livre, poderemos 
ingressar no seu aprendizado prático propriamente dito. Seguiremos em nosso modelo 
didático a seguinte estratégia (tabela 05): 
 

Figura 4- Gimp Figura 5- Scribus Figura 6- Blender 
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Tabela 05 
 

Esse modelo de ensino voltado para o aprendizado de softwares é o proposto pela 
maioria dos  livros e cursos, porém há de se observar pela literatura vigente, que sua 
aplicação é muitas vezes deficiente, pois não lida com exemplos práticos aplicáveis a 
situações cotidianas do mercado, ou mesmo acadêmicas. Assim, neste guia lidaremos 
com exemplos práticos aplicados a atividade do designer, não é função dele, entretanto, 
ensinar design, esse conhecimento é adquirido em faculdades e com constante estudo e 
prática. Ao longo de nosso percurso entenderemos as funções do programa, de acordo 
com suas necessidades, simplesmente porque mostrar determinado recurso e lá na 
frente, uma aplicação, é contraproducente e pouco prático. 
 
Cabe ressaltar que a maioria das modernas interfaces de interação com o usuário, para 
softwares de computação gráfica, seguem um estilo muito próximo ao adotado pela 
Corel e Adobe: No lado esquerdo temos a Toolbox (caixa de ferramentas) , no topo 
funções básicas, como salvar, cortar, abrir etc., e as opções da ferramenta selecionada, 
no meio temos o área de trabalho(main) com  
nosso documento aberto para edição e acima de tudo, os menus com opções gerais, 
geralmente por 
ordem, Arquivo(File), Edição(Edit), outros menus..., Janela(Window), Help(Ajuda). 
 
Nossa proposta com esta apostila é apresentar um tutorial do principal programa livre 
para Computação gráfica que está em ascensão: O Blender 3D voltado para 
computação gráfica tridimensional, design, CAD e até edição de vídeo, sendo inclusive 
comparado ao 3D Max em termos de recursos. 
 
 
 

 
 

1.O que é? 
2.Recursos 
3.Onde Obtê-lo? 
4.Como Instalá-lo? 

 
 

 
1.Caixa de ferramentas 
2.Opções das ferramentas 
3.Menus 
4.Área de trabalho 
5.Criação de documentos 
6.Edição 
7.Salvar 
8.Exportar 
9.Importar 

 

Software Usuário Resultados 

Uso 

 
1.Aprendizado 
2.Capacidade de  
elaborar novos 
trabalhos com os 
conceitos aprendidos. 
3.Capacidade de 
reproduzir os 
conceitos. 
4.Ser vetor de 
conhecimentos. 

 

 
1.Leigo 
2.Detém  
conhecimento básico 
em interfaces 
3.Interessado 
 

 

Proposta para Didática de Ensino 
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2.1 O que é Blender? 
 

lender é um Software Livre para computação gráfica 3D, distribuído sob a licença 
GPL (General Public License ), repleto de recursos. Inicialmente era um projeto 
proprietário de um empresa chamada NaN (Not a Number), de Ton Rosendaal, a 

empresa era especializada em animação e produção de mídia e comunicação visual, 
isso lá nos anos 90.Porém uma crise econômica abalou-a, o que forçou a empresa a se 
desfazer de seu produto, o Blender, que a época era proprietário. Houve uma grande 
comoção por parte dos usuários que resolveram então, levantar capital para comprar o 
software e lançá-lo numa licença livre. Surpreendentemente em pouco tempo, 
conseguiram a soma, em doações, de $1.000.000,00 e adquiriram definitivamente o 
aplicativo. Que posteriormente foi doado a comunidade do Software Livre.  
 
Atualmente o Blender é mantido pela Blender Foundation, na Dinamarca, e já foi usado 
profissionalmente na confecção do curta metragem, Elephants Dream e dos Filmes 
Homem Aranha  2 e Plumíferos, enquanto segue sendo utilizado por agências de 
publicidade e comunicação ao redor do mundo. Um novo longa metragem, chamado 
Peach e um game, Apricot, estão em fase de conclusão. Blender é recomendado pela 
Peugeot para seu concurso de modelagem de carros, o Peugeot Design Contest. 
 

 
Aparentemente o Blender é um programa difícil, contudo é preciso levar em 
consideração que todos os softwares da área são, por natureza, complexos, Sendo o 
Blender não mais difícil que os equivalentes mais utilizados do mercado, como o 3D 
Studio Max ou o Maya. 
 
 
 
 
 
 
 
 

B 

Figura 7- Interface padrão do Blender 
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2.2 Recursos 
 

Alguns dos recursos do Blender só são encontrados em gigantes líderes de mercado, 
são eles: 
 

 Dinâmica de corpos rígidos e macios, D 
 Dinâmica de fluídos e partículas,   
 Modelagem por subdivisão e por curvas,  
 Módulos para animação, inverse kinematics,  bones e esqueletos e animação 

não-linear, 
 Game-engine,  
 Módulo de edição de vídeo e áudio,  
 Shaders, NURBS, escultura digital (como o Z-Brush),   
 Radiosidade, Ray Tracing. 
 Compatível com renderizadores externos (YafRay, Aqsis, Indigo, PovRay, etc.) 
 Programação de interatividade (jogos e passeios virtuais 3D).  
 Importa e exporta modelos compatíveis com outros programas (3DS, VRML, X, 

OBJ, LWO, etc.)  
Tabela 06 

 

2.3.Como obter e Instalar o Blender 
 

2.3.1Acesse o site http://www.blender.org e clique no ícone “Download Now”, conforme 
a Figura 8 abaixo: 

 
 

2.3.2 Suponho que você esteja utilizando o Windows XP/Vista, sendo assim escolha a 
opção mostrada na Figura 9 ao lado do ícone da caixinha e clique para fazer o 
download. Se você estiver utilizando o XP, precisará do Microsoft Visual C++ 2005 
Redistributable Package (x86) , faça download do mesmo clicando no link 
correspondente logo abaixo. Você entrará no site da Microsoft e baixará o arquivo 
vcredist_x86.exe.  

Figura 8: Clique em Download now e seu 
download se iniciará imediatamente. Figura 9: Clique na Opção "Blender 2.45 Installer (8 

MB)" 
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2.3.3 É possível também que você necessite do Python, um programa auxiliar 
fundamental para o funcionamento do Blender. Baixe-o- em 
http://www.python.org/download/, escolha a opção Python x.x.x Windows installer  ou a 
mais atual. Lembre-se que x.x.x é a versão, que poderá mudar com o tempo, 
atualmente, estamos na 2.5.2 
2.3.4 Pela seguinte ordem, instale os arquivos com duplo-clique, método tradicional de 
instalação do Windows, o famoso “next, next e finish” . 
 

 Microsoft Visual C++ 2005 Redistributable Package (x86) 
 Python 
 Blender-2.45 

Tabela 07- Requerimentos para oBlender 2.45 
 

Existem também versões disponíveis para Linux e MacOS X, escolha a que lhe for mais 
conveniente. No Mac a instalação se resume ao método “arrastar e saltar” na pasta 
Applications. Já no Linux é possível, para Debian, Ubuntu e derivados utilizar o comando 
“apt-get install blender” num terminal de texto. 
 
O Blender é exatamente igual nos três sistemas, pois roda utilizando a mesma engine, a 
OpenGL. 
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interface do Blender é completamente diferente do que conhecemos como GUI 
(Graphic User Interface), para Windows. Assim que você tiver instalado o 
software, vá para o Menu Iniciar e procure pela sessão “Blender 

Foundation>Blender>Blender” em Todos os programas. O Blender será iniciado. 
Obs.: Não feche a janela auxiliar em DOS, pois ela é responsável pelos sub-processos 
do Blender.  
Pronto! Vamos nos deparar com o “monstro”, mas não se preocupe, porque a pesar das 
sete cabeças ele não é tão assustador. Por padrão o Blender Acompanha três janelas, 
assim que você o Abre. São elas:   

 User Preferences em amarelo no box da Figura 10 
 3d view em Verde-Limão, 
 Buttons-Window em vermelho.  

Tabela 08 
Essa organização é totalmente personalizável, através do conceito de Subdivisão da 
área de trabalho, em breve veremos como isso funciona. 
A User preferences mostra as opções referentes ao trabalho em voga, algo como a 
velha barra de salvar, editar, etc. que acompanha a maioria dos software do mercado, 
porém não tão simples. 

 
 

A 

Figura 10- Funcionamento da interface do Blender 
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Perceba que a User preferences tem os menus mostrados na figura abaixo: 

 
Eles vão de File até Help. Posteriormente, falaremos mais sobre isso. Logo abaixo dele 
temos a 3D View, (em verde-limão na figura 10 acima),essa janela serve para 
elaborarmos todo o nosso trabalho de modelagem e a maior parte de nossas 
animações. Por padrão, já temos um cubo apresentado em vista superior. 
 
A última janela é a Buttons Window (Em vermelho na figura 10), ela encerra opções de 
textura, animação, efeitos de modelagem, renderização etc. É  formada por vários 
botões e cada um com uma função específica.  
Agora é preciso que você entenda a lógica do software. Cada janela dessas tem um 
menu que pode estar no topo ou na base, esse menu permite ter acessos inerentes a 
janela em questão e nos dá a possibilidade de transformar uma janela em qualquer 
outra, assim a Buttons Window, pode se transformar na 3dView, por exemplo. Veja que 
eu dividi, na figura 10, o blender nas 3 janelas padrões e os menus delas estão lá 
também. Um exemplo é o menu da Buttons Window, que pode ser visto na figura 12:  
 

 
Cada janela tem seu próprio menu, e cada janela pode se transformar em outra, através 
do acesso ao atalho no canto esquerdo, conforme mostra a figura 13. Lembre-se que 
todas as janelas têm esse botão. 

 
 
Veja o que acontece ao clicarmos com o botão esquerdo do mouse, sobre o botão de 
atalho: 

Figura 10 

Figura 11- Menu padrão da Buttons Window. 

Figura 12: A seta aponta 
para a janela de atalho, 
que cria uma 
"transformação". 
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Aparece o menu Window Type (acima, figura 15). Nesse caso utilizamos o atalho 
contido na janela Window Type, mas você pode utilizar qualquer um de qualquer janela. 
Vamos ver como isso funciona? Selecione a opção Buttons Window na janela 3dView e 
você verá que ela se transformou numa buttons Window também, igualzinha a inferior 
do programa, ou seja, você pode ter duas janelas idênticas em funcionalidades. Veja na 
figura 16 abaixo. 

 

 
Figura 15- Window 

type 

Figura 13: Transformamos nossa 3d view numa buttons Window, 
utilizando o botão de atalho presente em todas as janelas. 

Figura 14 
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Ok, nossa interface ficou horrível, certo? Mas isso porque ainda não sabemos como 
consertá-la. Perceba que em cada janela, temos bordas, essas bordas subdividem a 
área de trabalho, e pairando o mouse sobre elas veremos uma seta de duas pontas 
(Figura 16). Pois bem, clique com o botão esquerdo do mouse sobre ela e arraste, é 
semelhante ao que você faz em outros aplicativos. Perceba que a área de trabalho foi 
redimensionada. Isso serve para adequar as janelas as suas necessidades. Ainda, 
clicando com o botão direito sobre ela, aparece o menu de gerenciamento de janelas 
(Figura 17), esse menu funciona serve para “fatiarmos” nossa área de trabalho, criando 
novas janelas, deletando, etc.  

  

 

 

Selecionando Split Area você irá subdividir sua área de trabalho criando uma nova 
janela, cópia da anterior e paralela a está, perceba que uma linha marcadora surgirá 
(Figura 18), possibilitando que você escolha exatamente onde quer colocar sua nova 
janela (Figura 19). Lembre-se que se você subdividir uma janela na horizontal, terá uma 
nova na vertical, se subdividir no canto da tela, terá uma nova na horizontal. Todas as 
novas janelas criadas serão clones e você poderá mudá-las usando o menu Window 
Type. 
 
Se quiser juntar as janelas é Simples. Tomando o exemplo anterior, clique na borda de 
uma janela com o botão direito e escolha Join Areas (Figura 20), uma enorme seta 
aparecerá indicando pra que lado você quer fazer a junção. Escolha e confirme clicando 
com o botão esquerdo, pronta duas janelas viraram uma (Figura 21). 

Figura 
16:Borda de 
cada janela 
redimension
ável  

Figura 17: 
Menu Split, 
para dividir á 
área de 
trabalho 

Figura 18: 
Uma vez 
escolhida a 
função Split 
você cria uma 
nova janela 

Figura 19: Nova janela gerada. 
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Também podemos eliminar os menus de cada janela, porém isso quase nunca é 
interessante para um iniciante. Esses menus são os headers, ou cabeçalhos, que já 
vimos como funcionam e podem ser eliminados clicando-se com o botão direito sobre 
eles e escolhendo a opção No header do menu de contexto Header (Figura 22), o menu 
irá sumir (Figura 23). Para trazê-lo de volta, clique na borda da janela e escolha Add 
Header (Figura 24). O novo Menu retornará na base da janela (Figura 25), portanto para 
colocá-lo no topo, que é o padrão do Blender, clique sobre ele e escolha, no menu 
Header, a opção Top. Pronto o menu está no topo novamente (Figura 26). 

  
 

 

 
3.1 Navegando na 3D View 
 

Depois de aprender a lógica da interface no Blender, pela ordem, aprenderemos a 
manipular os objetos na 3D View, que é nosso palco, onde o “show” realmente 
acontece. Perceba na interface que temos um cursor em forma de mira, o Cursor 3D. 

Figura 20: Figura 21: 

Figura 22: Menu 
Header 

Figura 23: No Header Figura 24: Adição de 
Novo header 

Figura 25: Janela sem header 



 26 

O cursor 3D funciona como uma mira, de fato, para manipulá-lo basta clicar na área de 
trabalho com o botão esquerdo do mouse, onde você clicar ele ficará. Sua função é 
especificar onde teremos a adição de novos objetos e recursos de edição. Não confundir 
com centro do objeto, que tem uma função complementar, nem com o Gizmo, as setas 
que servem para mover, rotacionar e escalonar os objetos . Veremos mais sobre eles 
adiante.Abaixo, na figura 27, você pode vê-lo. 
 

 
 
Para navegar na 3D view, utilizamos o mouse e o teclado. Essa é uma máxima do 
Blender, que assusta o iniciante, mas  na verdade tende a agilizar em muito o processo 
de modelagem e animação para um usuário intermediário ou avançado. 
Na tabela abaixo vemos os atalhos para a 3D view. Não tem jeito, essa tabela é super-
padronizada e está em todos os manuais e livros de Blender. Tem que aprender, 
pratique com o cubo que já está por padrão assim que você inicializa o aplicativo. 
 

Botão Esquerdo do Mouse(BEM)-Define 
a posição do cursor 3D. 

 
Botão Direito do Mouse(BDM)-Seleciona 
Objetos, vértices, arestas e faces. 

 
Botão do Meio- Controle em 360° da 3D 
view, segure e arraste 

 
Scroll ou rodinha do mouse- Controle de 
Zoom 

 

Figura 27: Cursor 3D em destaque note que ele é diferente das setas 
manipuladoras do objeto 
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SHIFT+Botão do meio- Controle de 
andamento da tela 

 
CTRL+Botão do meio- Controle  
de Zoom 

 
Tabela 09 

 
Além desses atalhos precisamos utilizar as vistas, não é mesmo? Você entenderá sua 
aplicação se treinar os atalhos abaixo (tabela 7), use o teclado ao lado como referência. 
 
 
Teclado Numérico Ação 
8- Rotaciona a visão para a frente 
7- Vista do Topo (Top View) 
6- Rotaciona a visão para a direita 
5- Visão em perspectiva ou paralela 
4- Rotaciona a visão para a esquerda 
3- Exibe a Vista da direita (Right View) 
2- Rotaciona a visão para trás 
1- Exibe a vista Frontal (Front View) 
0- Vista da Câmera  
CTRL+7- Vista de baixo (Bottom View) 
CTRL+3- Vista da Esquerda (Left View) 
CTRL+1- Exibe a Vista de trás (Back 
View) 
+- Aumenta o Zoom 
--Diminui o Zoom 

 
 

 

Tabela 10 
 

Abaixo temos um exemplo de imagem em perspectiva (NumPad 5) na visão da Câmera 
(NumPad 0). Treine bastante até ficar bem prático (Figura 28). 
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Complementando, você pode ver o efeito obtido ao se utilizar as vistas: 

 
 

3.1.1  View Properties (Propriedades de visualização) 
 
O menu View Properties pode ser acessado com a opção do menu View>View 

Figura 28: Primeiro coloque na visão 
perspectiva(Numpad 5) e depois na da 

câmera(Numpad 0). 

 
Tabela 11 
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Properties (Figura 29), ele também tem a função de ajustar parâmetros da 3D view, nele 
você pode ajustar  a posição do Cursor 3d (3D cursor), até onde vai o campo de visão 
na 3D view (Clip Start e Clip End). Naturalmente, o Blender é riquíssimo em recursos, e 
alguns só poderão ser descobertos com a prática portanto treine as opções do menu 
View Properties. 
 

 

 
Uma observação importante é que você pode salvar seu arquivo no Blender apertando 
CTRL+W ou indo no menu File>Save no topo da tela. `Para limpar  a cena pressione 
CTRL+X, e seu blender volta ao início do uso. Lembre-se sempre de salvar seu trabalho, 
pois o Blender tende a fechar bruscamente, sem perguntar, seu arquivo anterior para 
criar um novo. 
 
3.1.2 Draw Type ou Modo de exibição. 
 
Um Software 3D consiste em uma modelagem num plano cartográfico x,y e z, e molda 
suas formas através de cálculos baseados em Wireframes, que são malhas de arame.  
   

                              
                    

Figura 31: Imagem em modo Solid 

Figura 29: Acesso ao 
menu View Properties 

Figura 30: Em Spacing você configura 
o Grid da 3D view e em View Câmera, 

o ângulo da câmera. Teste os 
parâmetros sem medo de errar! 
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Você pode escolher o modo de visualização das formas em Draw Type , o menu que 
pode ser visto na figura 31. Existem 5 modos que podem ser alternados com os atalhos:  
 

 Z: Wireframe/Solid 
 SHIFT+Z: Wireframe/ Shaded 
 Clique no Menu: Escolha do Bounding Box, ultra-rápido. 

Tabela 12 

Imagens muito pesadas tendem a saturar o computador, portanto ficam mais leves se 
trabalhadas no modo Wireframe (figura 32). 

 
3.1.3 Widget Control ou Gizmo 
 
O gizmo ou widget control, é aquele conjunto de setas correspondentes aos eixos x, y e 
z que serve para a manipulação de nosso objeto na 3D view. Quando você seleciona um 
objeto, com o botão direito do mouse, ele aparece. Se você arrastá-lo para qualquer dos 
eixos, clicando na seta com o botão esquerdo e arrastando no sentindo desejado,  seu 
objeto subseqüentemente será arrastado também na mesma direção. 
 

Figura 32: Imagem em modo Wireframe. 
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Lembre-se: 
-Botão Direito do Mouse: Seleção de objetos 
  -Botão Esquerdo do Mouse: Localizar 3D Cursor e arrastar objetos com o gizmo. 

Tabela 13 

Ele também pode tomar a forma de um círculo para você rotacionar o objeto. O modo de 
uso segue sendo o mesmo, você rotaciona o objeto em qualquer direção: 

 
 
Ou ainda de um eixos com cubos na ponta para que você possa redimensionar sua 
forma no sentido desejado (figura 35). 
 
 
 
 
 

Figura 33: Esse gizmo esta presente em 
praticamente todos os softwares 3D, como o 

3D Studio Max, por exemplo. 

Figura 34: Rotacione escolhendo o eixo e arrastando no sentido 
desejado. 
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Para escolher a forma do gizmo, selecione o objeto acesse o menu mostrado na figura 
abaixo: 
 
 

 
Cada ícone desse menu tem uma função referente a: 
          
         -posição,(triângulo),  
         -rotação (círculo),   
         -escala(quadrado),  

Tabela 14 

Para ativar o gizmo, ou desativá-lo, clique sobre o ícone da mãozinha.  
 
Mais uma vez: O botão direito do mouse serve para seleções de objetos, vértices, faces 
e segmentos. Ou seja, as seleções são feitas, em suma, com esse botão. Mais a frente 
veremos opções complementares para esta função. 
 
3.1.4 Centro dos objetos 
 
Esse  pequeno pontinho rosa que aparece no meio do objeto, inscrito no interior do 

 
 
 
 
 

Figura 35: escalone seu objeto no eixo desejado e veja os efeitos 

Figura 36: A "mãozinha" desativa o gizmo 
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gizmo. é seu centro (figura 37). Ele é muito importante pois irá definir dentre outras 
coisas, as transformações que veremos posteriormente. Mas nem sempre o objeto tem 
seu centro no meio. 

 
3.1.5 O menu Snap 
 
O menu Snap serve para que possamos interagir com o cursor 3D(figura 38). Como já 
foi dito, o cursor 3D define a posição de novos elementos e nos ajuda na edição dos já 
existentes. Para usar o menu Snap, clique na 3D view, selecione um objeto, e aperte as 
teclas de atalho SHIFT+S. 

 
 
As opções estão listadas na figura acima.  
 
Selection > Grid, alinha o objeto a grade.  
Selection Cursor é muito usado e serve para alinhar o objeto ao cursor 3D.  
Cursor > Grid alinha o cursor 3D a grade.  
Cursor > Selection, alinha o cursor com o objeto selecionado e  
Cursor > Active serve para alinhar o cursor ao objeto ativo.  

Tabela 15 

Treine essas opções pois as usaremos muito. Um exemplo de aplicação pode ser visto 

Figura 37:Objeto com seu 
centro apontado pela seta 
vermelha.  

Figura 38- Menu Snap para interação do objeto com o 
cursor 3D.  
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abaixo nas figuras 39 e 40. 
 

 
 

3.1.6 O Salvando seus arquivos 
 
Antes de passarmos para o próximo tópico é importante aprender a salvar arquivos. 
Para salvar um documento, aperte sobre a 3DView CTRL+S, CTRL+W ou vá no menu 
File>Save. Uma tela se abrirá , conforme  abaixo (figura 41). É importante se acostumar 
com esse painel, o File browser, porque ele não se parece em nada com o padrão de 
janelas do Windows, apertando o botão P você sobre um nível acima e escolhe a pasta 
onde quer salvar seu arquivo. A extensão padrão do Blender, chama-se Blend, assim 
você terá algo como seu arquivo.blend. Para sair da file browser aperte simplesmente 
ESC. Uma dica é você salvar tudo na raiz do disco c:\ se estiver no Windows, depois  
transfira o arquivo para sua pasta pessoal. 

Figura 39: Objeto Longe do cursor 3D. 
 

Figura 40: Ao aplicar a opção selection > 
cursor, o objeto seguiu o cursos 3D. ficando 

em sua posição. 

 
Figura 41: File Browser: Janela auxiliar  
para salvar arquivos, entre outras coisas. 
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ntes de falarmos das opções da Buttons Window, a janela de botões no painel 
inferior, dissecaremos as funções do cabeçalho da 3D view, pois este nos 
permitirá editar objetos. Como o Blender é um programa que faz uso extensivo de 

atalhos, é perda de tempo focar apenas as funções presentes apenas nos menus. 
Entretanto quando a memória for insuficiente para decorar uma quantidade substancial 
de atalhos, vale a pena usar os menus auxiliares. 
 
Para editar um objeto, simplesmente aperte a tecla TAB, assim ele entrará no modo de 
edição, porque o Blender por padrão, mantém seus objetos em modo Object, que é o 
modo destinado a manipulação do objeto em essência, sem modelar sua malha. Um 
outra maneira é clicar no menu Object, como visto na figura abaixo (figura 42), e 
escolher a opção Edit. 
 

 
 
O objeto assumirá a seguinte aparência: Rosa semi-transparente com vértices salientes. 
Bem, mais e daí? Para que nos serve entrar nesse modo Edit se não sabemos editar? 
Calma. Vamos aprender os conceitos de modelagem para poder modificar nossas 
formas. 
 

A 

Figura 42: TAB é a tecla de chaveamento entre modo 
Object e EDIT 
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Todo objeto, em geral, é um mesh, um conjunto de faces, vértices e segmentos, que 
podem ser moldados, tal como os artistas e designers fazem com argila e resina. No 
Blender para editar algo nos valeremos das seguintes ferramentas e conceitos simples, 
que em geral são usadas mesmo pelos modeladores mais experientes em qualquer 
software 3D. As figuras abaixo estão destacadas 
para melhor entendimento. 
Os conceitos referentes a forma, são: 
 

 Vértice. Um ponto do objeto, como em geometria,... 
 Aresta. Um segmento de reta. 
 Face. Um lado de um objeto qualquer 

 
  

Tabela 16 
 
Para selecionar um vértice, aresta ou face, entre no modo Edit (TAB) e escolha modo de 
seleção que pode ser: 
  

 Vertex- Vértice 
 Edge- Arestas 
 Face- Face. 

Tabela 17 

 

Figura 44: Vértices marcados 
com com círculos vermelhos 
 
 

Figura 45: Arestas mascadas 
em linhas vermelhas 

Ilustração 46: Faces Marcadas 
com marcas vermelhas. 

figura 43: Objeto no modo edit, 
caspecróseo. 
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O modo de seleção está no menu da 3D view, mostrado abaixo (figura 47): 
 
 
 
Quando você selecionar um dos modos, seu objeto mudará de aspecto, ressaltando o 
modo escolhido. Lembre-se que você somente poderá selecionar as partes de um objeto 
quando estiver no modo Edit, assim clique nos vértices com o botão direito do mouse 
para selecioná-los. 
 
Ok, você sabe que pode mover, rotacionar e escalonar um objeto para qualquer lugar 
em qualquer direção ou sentido, porque treinou os atalhos mostrados anteriormente, 
treine a movimentação de objetos em diversas direções, com o Gizmo e com esses 
novos atalhos que mostrarei, basta selecionar o objeto com o botão direito do mouse, e 
pressioná-los. Dica coloque sua visão na Top View: 
 

 G- Grab- Move seu objeto em qualquer direção 
 S- Scale- Escalona seu objeto a partir do centro. 
 R- Rotate- Rotaciona- seu objeto em qualquer direção 

Tabela 18 
 
Você também já sabe que existem 3 eixos cartesianos, o X, Y e o Z. Bom, combinando 
as funções de movimentação, escala e rotação com os eixos, você aplicará as 
modificações na direção desejada. Assim ao apertar G e depois X, uma linha aparecerá 
mostrando seu objeto travado no eixo X,Conforme figura abaixo, basta arrastar o mouse 
e clicar com o botão esquerdo (que fixa qualquer tipo de transformação) no ponto em 
que você quer que sua forma fique (figura 48): 
 
 
 
 
 
 
 
 

Figura 47: No menu da 3D view procure por 
estes ícones 

Figura 48: Neste caso eu apertei G<grab> e fixei 
com X(eixo X) agora movo com o mouse no sentido 

escolhido 
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O mesmo princípio pode ser aplicado aos eixos Y e Z, lembre-se sempre de usar vistas 
ortogonais.Você também pode escalonar seu objeto em qualquer dos eixos, o 
procedimento é análogo: Selecione a forma, aperte S, o eixo desejado (X,Y ou Z) e 
arraste o mouse. Abaixo eu escalonei meu mesh no eixo Y. 
 

 
 
Treine o mesmo princípio com as funções de rotação.   
 
4.1 Modificando objetos no modo Edit 
 

Vamos agora para o modo de edição.Aperte TAB e seu objeto tomará a forma rósea 
semi-transparente com pontos de controle salientes chamados vértices, você está no 
modo Edição, ou Edit Mode. Clique sobre um desses vértices com o botão de seleção, 
(Botão direito do mouse) e arraste em qualquer direção, para fixar, clique com o botão 
esquerdo. Veja abaixo o que acontece: 
 

 
 
Lembre-se que você está no modo Edit Mode, esse modo existe para que possamos 
modelar  
nossas formas, enquanto o Object Mode para que possamos adicionar e movimentar os 

Figura 49: Escalonamento no Eixo Y, com as 
teclas S(scale) e Y para fixar. 

Figura 50: Objeto no modo edit, sofrendo uma 
transformação de arrasto com G (Grab) 
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objetos em todos os sentidos. Se você apertar SHIFT enquanto seleciona, terá dois 
vértices selecionados. E o que acontece quando se seleciona dois pontos? Você tem 
uma reta. No nosso caso um Edge ou aresta (figura 51).  
 
Lembre-se: SHIFT é Botão de adição, assim como no Corel Draw, Illustrator etc. 

Tabela 19 

 
 
Arraste, mova, escalone  e rotacione, em todos os modos, Vertex, Edge e Face, seu 
objeto inicial, que é sempre um cubo. Abaixo você pode ver opções básicas de 
modificação, esses são seus primeiros conhecimentos de edição de objetos, portanto 
preste bastante atenção e procure executar as funções abaixo, lembre-se sempre que 
você deve utilizar o modo “Edit Mode” (TAB). 
 

  
 

Figura 51: Dois pontos nos dão uma 
reta. 

Figura 52: Movimentando um 
Vértice no modo vertex. (G) 

Figura 53: Movimentando uma 
aresta, no modo Edge (G). 

Figura 54: Movimentando uma Face 
no modo Face (G, Z e arraste o 
mouse, G, Y e arraste o mouse) 
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Funções de escalonamento 
não existem no modo vertex, 
porque um ponto, não tem 
dimensão teórica. 

  

 
 
 
Funções de rotação não 
existem no modo vertex, 
porque um ponto, não tem 
dimensão teórica. 

Tabela 20 
 
4.2 Extrusão 
 

A extrusão consiste em prolongar uma extremidade da forma gerando uma nova divisão 
na malha. Você deve, obrigatoriamente aprender o atalho de extrusão para o Blender:  
 

E- Extrusão- Prolonga uma parte selecionada da superfície, gerando uma subdivisão 
na malha. Seu atalho correspondente é a tecla E. 

Tabela 21 
 

Figura 55: Escalonando uma Aresta 
no modo Edge, no eixo X, (aperte S 
depois X e arraste o mouse, depois 
fixe com o clique do botão esquerdo 
do mouse) 

Figura 56: Escalonando uma face no 
modo Face em todos os eixos, nesse 
caso a seleção cresce em todas as 
direções, porque o eixo não foi 
especificado pelos atalhos X, Y ou Z. 

Figura 57: Rotacionando uma aresta 
no modo Edge no eixo Y (Selecione a 
Aresta, R, Y e controle com o mouse, 
depois fixe clicando com o B. 
Esquerdo)  

Figura 58: rotacionando uma face no 
eixo Z. (Entre no modo Face, 
selecione a face, aperte R, Z,e 
controle com o mouse, fixe clicando 
com o botão esquerdo do mouse) 
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Você pode, via de regra, extrudar Vértices, Arestas e Faces. Basta entrar no modo 
correspondente e realizar a extrusão. Por exemplo, para extrudar um vértice (Vertex), 
entre no modo de Edição (TAB), Selecione o ponto (Botão direito do Mouse), e aperte E, 
depois arraste o mouse e escolha o local onde você quer colocar sua nova extrusão, ou 
fixe um eixo X, Y ou Z. Depois fixe o local clicando com o Esquerdo do Mouse. O 
resultado da extrusão de um vértice é uma aresta. Conforme você pode ver na figura 
abaixo (figura 59). 

 
 
O resultado da extrusão de uma aresta é uma face (Figura 60): 
 

 
 
E quando extrudamos uma face temos uma forma geométrica sólida: 

 
Figura 59: Selecione o Vértice,  Pressione E,   

trave no eixo Y, então arraste, até o ponto 
desejado e fixe, clicando com o botão 

esquerdo do mouse. 

Figura 60: Aqui você seleciona a aresta e 
segue os passos anteriores, porém fixe no eixo 

Z. 
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Vamos fazer uma extrusão mais precisa: 
 
1. Utilizando o cubo inicial vá para a visão da câmera (NumPad 0),( figura 62.) 

 
 
2. Entre no modo Edit (TAB) e Selecione uma face no modo Face, nesse caso a do topo. 
 

 
3 . Extrude com a tecla E, essa face, trave no eixo Z, mais não mova nada. 

Figura 61: Extrude a face no eixo X, 
utilizando o mesmo raciocínio. 

Figura 62: pressione 0 no teclado 
numérico, selecione a forma e entre no 

modo edit (TAB) 

Figura 63: Selecione com o botão direito 
do mouse 
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4.Aperte 2 no NumPad do teclado e fixe com o clique do botão esquerdo. 
 
Veja que ele escalonou com a medida absoluta de 2. Esse valor pode ser modificado e é 
bem útil quando precisamos editar com precisão. 
 
Treine misturando os atalhos de Escalonamento (S), Movimentação (G) e rotação ( R), 
conjuntamente com o atalho de extrusão (E), para a obtenção de novas formas, a partir 
do cubo inicial, lembre-se que o Blender é um programa muito lógico, então ele segue 
postulados básicos de desenho geométrico e perspectiva. 
 
 

 
4.2.3 Extrusão Orgânica 
 
Um tipo diferente de extrusão chama-se Extrusão Orgânica, peque o objeto entre no 
modo edit (TAB), selecione uma face (figura 66), um vértice um um edge e segure 
CTRL, depois dê um clique com o botão esquerdo do mouse no local onde você gostaria 
de ter um prolongamento da forma.Pronto. Você pode repetir o processo inúmeras 
vezes (figura 67). 
 

Figura 64 : A extrusão sobrepõe uma 
face sobre a outra. 

Figura 65: a extrusão seguiu a precisão  
de 2 unidades 
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4.2.4 Opções avançadas de extrusão 
 
Às vezes aparecem opções em um menu quando selecionamos mais de um vértice 
(com Shift), sempre no modo Edit,  e pedimos uma extrusão, são elas: 
 
Modo 
Vertex:________________________________________________________________ 
 
a. Only Vertices- Somente vértices. 
b. Only Edges- Somente arestas, nesse caso teremos uma face 
c. Region- Uma quantidade de vértices delimita uma região que pode ser extrudada 
inteira. 

Tabela 22 
 
Modo 
Edges:________________________________________________________________ 
 
 

 
a. Only Edges- Extruda apenas as arestas 
b. Region- Extruda uma região inteira. 
 

Tabela 23 
 
Modo 
Faces:________________________________________________________________ 

Figura 66- Face selecionada Fgura 67- Várias Extrusões Orgânicas 
aplicadas 

Figura 68 Figura 69 
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a.Region- Várias faces ao mesmo tempo, de modo dependente. 
b.Individual Faces- Faces são extrudadas individualmente, sem depêndencia 

Tabela 24 
 
Teste as opções para entender seu funcionamento. 
 
 
4.3 Seleção Avançada de Objetos, Vértices, Segmentos e 
Faces. 
 

Além do Shift para adicionar objetos a seleção, você pode utilizar outras teclas também 
combinadas: 
 
A- Seleciona todos os objetos da cena no modo object, incluindo câmeras, luzes etc. 
(figura 71). No modo edit seleciona todos os vértices, edges ou faces da cena (figura 
72). 
 

  
A 2x- Deseleciona todos os objetos da cena.  
ALT+clique com o botão direito do mouse- seleciona um Vertex Loop (Figura 73), um 
segmento em forma de anel, muito importante quando estivermos trabalhando com 
formas orgânicas. 

Figura 70 

 
Fgura 71- A para selecionar todos os 

 objetos da cena 

 
Figura 72- A no modo Edit para selecionar 

todos os vértices do objeto. 
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B- Box select- No modo edit você aperta B, clica com o botão esquerdo do mouse, 
arrasta e seleciona uma determinada quantidade de vértices (figura 74). 

 
B 2x- Agora você tem um bastão para selecionar áreas com maior precisão:Clique, 
segure e arraste o botão do mouse (Figura 75). 
 

                            
Para sair do Box select, clique em algum lugar com o botão direito do mouse. 
 
 
 
 

Figura 73- Vertex Loop 
selecionado 

Fgura 75- Box Select na forma de 
pincel. 

Figura 74- Box Select quadrado 
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abemos o básico sobre a edição de objetos, em especial o nosso cubo que já está 
na 3D view por padrão, porém não sabemos como adicionar novos objetos a 
nossa cena. Mas vamos resolver isso agora. 

 
Para adicionar um objeto ao Blender, na 3D view, pressione a barra de espaço e você 
verá o menu de Adição de Objetos, use sempre a visão superior (Num Pad 7), ou outra 
ortogonal, o menu  chama-se Add (figura 76): 

 
Esse Menu é extremamente útil e ele encerra funções de edição a adição de objetos. Ele 
também se encontra no topo do menu superior, como você pode observar, só que lá ele 
tem menos recursos. Para Adicionar objetos a nossa cena, vamos utilizar algumas 
funções do menu, só é seguir a ordem e adicionar as formas, clicando na escolhida: 
 
 

 Add > Mesh> Plane ou Cube ou Circle ou UV Sphere ou Icosphere ou 
Cylinder ou Cone ou Grid ou Monkey ou Torus. 
 

 Add>Surface> Nurbs Curve ou Nurbs Circle ou Nurbs Surface ou Nurbs 
Tube ou Nurbs Sphere ou Nurbs Donut. 
 

 Add> Meta>Meta ball ou Meta Tube ou Meta Plane ou Meta Ellipsoid ou Meta 
Cube 
 

Tabela 25 
 
Essas formas são as essenciais, de especial importância para nós, são os Meshs, que 
podem ser encontrados em Add > Mesh. Para adicionar um objeto a cena, esteja 
sempre no modo objeto, e usando a barra de espaço, selecione as formas, lembre-se de 
usar sempre uma vista ortogonal,  
(NumPad 7, 1 ou 3), porque do contrário, o objeto poderá ficar mal posicionado, além do 
mais, toda nova adição é feita em paralelo ao observador, ou seja de frente para você. 
 
No exemplo Abaixo (Figura 77), compus uma cena com vários objetos. 

S 

Figura 76- Menu Add, com uma série de opções para 
adição de objetos. 
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ATENÇÃO! 
Quando você adiciona uma nova forma, ela já entra no modo edit, então para colocar 
mais um, saia e volte para o modo object (TAB). Sempre repita isso, a não ser que 
queira adicionar duas formas no modo edit, nesse caso, você terá um objeto ligado ao 
outro, ou seja quando voltar ao modo object, ao selecionar um terá selecionado o outro 
também (figura 78).  

Tabela 26 
 
 
No exemplo abaixo, perceba que coloquei muitas formas no modo edit e que quando 
voltei para o Object elas ficaram “ligadas”. Treine bastante a adição de objetos 
especialmente os do menu Mesh. Que são primitivas simples. 

 
Lembre-se sempre que o objeto é adicionado onde estiver o cursor 3D. 
 
5.1 Abrindo objetos de outros arquivos 
 

Suponhamos que você modelou uma maçã e quer colocar em sua cena, o processo é 
simples 
 

 File > Append > Localize o arquivo com a extensão .blend (figura 79) 
 
Um arquivo do blender contém todos os elementos da cena, Câmeras, cenas, textos etc. 
Mas se você quer o objeto, deve selecionar a opção object dentro do seletor e escolher 
o que quer (figura 80).  
 

Figura 77- Cena composta por vários meshs. 
Figura 78- como adcionei dois 
objetos no modo Edit eles 
ficaram "linkados". 
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5.2 Duplicando Objetos 
 

 
SHIFT+D- Cópia Simples (Figura 81) 
ALT+D- Duplica Objetos com links, de modo que o primeiro ficará integrado ao 
posterior (Figura 82) 
 

  
 

5.3 Pivot dos Objetos 
 

O pivot serve como ponto de referência para todas as operações de edição (escala, 
rotação etc.), ele encontra-se no cabeçalho da 3d view (figura 83): 
 

 

Figura 79- Importando 
arquivos com a extensão 

blend 

Figura 80- o diretório 
object contém o mesh. 

Figura 81- Na cópia simples não há link. portanto é 
possível mudar a cor de um objeto. 

Figura 82- Na cópia com Links, alterando um objeto o 
outro acompanha a mudança. 

Figura 83- O menu Pivot em destaque. 
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Suas opções são, de acordo com a  numeração da figura acima: 
 
1. Active Object: o objeto ativo é referência para transformações. 
2. Individual Object Centres: o centro dos objetos é a referência. 
3. 3d cursor: A referência para transformações é o cursor 3d. 
4. Median Point: O ponto médio dos objetos é a referência para transformações 
5. Bounding Box Centre: O centro de um cubo imaginário é usado como referência. 

Tabela 27 
 
Não se preocupe, esses conceitos não são muito importantes por hora. 
 
5.4 Transformação precisa de objetos adicionados 
 

5.4.1 Precisão da grade 
 
selecione um objeto, pressione CTRL e escalone, mova ou rotacione (já vimos isso) 
enquanto segura a tecla, assim você edita o objeto com a precisão da grade (Figura 84) 
 
 

 
5.4.2 Precisão milimétrica 
 
Aperte CTRL+SHIFT após a seleção de um objeto, e você poderá editá-lo de diversas 
formas, (escalonar, girar, rotacionar etc.), com precisão milimétrica, tanto no modo edit 
como no object. 
 
Você também poderá acessar o menu Object > Transform properties (figura 85 )e 
modificar parâmetros precisos de acordo com os eixos. Entretanto essa função só é 
acessível quando seu objeto estiver no modo object. 
 

Figura 84- O objeto da direita foi escalonado com a 
precisão de números inteiros, de 100 em 100. 
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5.4.3 Espelhando Objetos 
 
Espelhe objetos utilizando o Atalho CTRL+M, selecione o eixo, conforme mostra a figura 
abaixo (figura 86): 
 

 
 

 

 
 
 
 
 
 
 

Figura 85- Transform Properties lhe dá a 
precisão necessária para realizar transformações 
específicas 

Figura 86- Objeto a ser espelhado com o atalho  
CTRL+M 

Figura 87- Objeto anterior espelhado no eixo X. 
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gora que aprendemos como adicionar e manipular objetos no Blender, 
basicamente, poderemos explorar o painel de botões que possivelmente 
despertou sua curiosidade e que se localiza na parte inferior do programa, é o 

Buttons Windows. 
 
Esse painel é dividido em sub-painéis ou sub-janelas e depois da 3d view é a janela 
mais importante do Blender, porque interage diretamente com nosso trabalho. Você 
pode acessá-lo pelos botões disponíveis na figura abaixo (figura 88), ou no menu 
Panels, vejas suas funções abaixo: 
 

 
 Logic- Parte interativa do Blender, com ferramentas de jogos. Por enquanto sua 

importância é baixa para o usuário iniciante 
 Script- Opções para configuração de Scripts. Pouco importante para o usuário 

iniciante 
 Shading- Opções gerais de iluminação, material, etc. Este painel é muito 

importante e está sub-dividido em: 
 Lamp- Opções para iluminação de nossa cena 
 Material- Opções para cores, reflexões e transparências de nossos objetos, 

entre outras. 
 Texture- Aqui temos as texturas que complementam os materiais. 
 Radiosity- Radiosidade do Blender 
 World- Configurações do ambiente de nossa cena, incluindo o céu 

 Object- Efeitos de animação, nomes e links para os objetos, além do Physic 
Buttons, opções para criar efeitos especiais 

 Editing- Opções referentes a edição do objeto em questão. 
 Scene- Aqui temos as opções para renderização e animação, este painel está 

dividido em três: 
 Render- Renderização, formato de saída para os arquivos etc. 
 Animation- Opções referente a animação, com frame rate etc. 
 Sound- Opções relacionadas ao áudio da animação. 

Tabela 28 
 
6.1 Câmera 
 

A Câmera é o objeto piramidal mostrado abaixo (Figura 89), em destaque róseo. Ela 

A 

 
Figura 88- o seletor na esquerda mostra o ícone da Buttons Window e seus sub-painéis correspondentes 
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pode ser selecionada com nossa tecla universal para seleção de objetos, o botão direito 
do mouse. Pode ser movida para qualquer direção com o atalho G e rotacionada com R. 
 
 
A câmera focaliza o objeto que será renderizado, e você pode acessar essa visão com a 
tecla 0 do teclado numérico. Após tomar sua visão você poderá obter o Zoom da câmera 
selecionando-a, apertando G e Z duas vezes, então mova o mouse para cima ou para 
baixo (figura 91). 
 

  
Quando estiver em uma visão qualquer, pressione CTRL+ALT+0, isso fará com que sua 
visão torne-se a da Câmera. Além disso qualquer coisa pode ser câmera, basta 
selecionar um cubo, por exemplo e apertar CTRL+0, o cubo vira câmera. Para reverter 
aperte ALT+0. 
 
6.1.1Atalhos para a Câmera: 
 
 
 
 
 
 

Figura 89- A câmera em destaque na cor 
rósea, contém a captura do que será 
renderizado 

Figura 90- visão da câmera obtida com NumPad 0 Figura 91- G e Z duas vezes, então regule a distância 
arrastando o mouse. 
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 Botão Direito do Mouse- Seleciona a câmera. 
 G- Move a câmera nos eixos especificados 
 R- Rotaciona-a nos eixos especificados 
 B. Direito do mouse, depois G, Z 2x, depois movimentação do mouse- 

Zoom da câmera. 
 CTRL+Alt+0- Faz com que sua visão torne-se a da Câmera 
 CTRL+0- Transforma seu objeto em Câmera 
 ALT+0- Desfaz a transformação. 

Tabela 29 
 
6.1.2 Propriedades da Câmera 
 
Selecione a câmera, vá para o sub-painel Editing e na janela Camera você poderá 
controlar algumas propriedades da câmera (figura 92) 

 Lens- Ângulo de abertura da câmera. 
 Ortographic- Visão da câmera em modo ortográfico, sem perspectiva. 
 Size- Tamanho. 
 Clipping- Start e End aumentam a profundidade da imagem, aumente sempre o 

valor de end, caso precise. 
 
6.2 Renderização 
 

Quando você aperta F12 sua cena é renderizada na visão da câmera. Daí a relevância 
de se utilizar um bom ângulo de câmera, antes de renderizar sua cena. Opções podem 
ser encontradas no sub-painel Scene >Format, onde você tem vários tipos de saída 
para gráficos e vídeos: JPEG, PNG etc. e AVI, PAL, NTSC etc. para vídeo, em size, 
você encontra o tamanho do arquivo, podendo editar o campo também nas coordenadas 
X e Y. BW, salva suas imagens em tons de cinza, RGB em cores, e RGBA em cores 
com transparência (Alpha Channel). 
 

Figura 92- Propriedades da Câmera. 
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Caso você tenha criado uma animação, pressionar  o botão Anim, na janela Anim, criará 
sua seqüência animada, ou um arquivo de vídeo, escolhido na janela Format. 
 
 

6.2.1 Janela Render 
 
Na janela Render (Scene > Render), você encontra o botão Render (F12), as opções 
Shadow, para ligar as sombras do objeto, EnvMap, para usar o ambiente na 
renderização, Pano, para utilizar visão panorâmica, cujas opções estão disponíveis em 
Xparts e Yparts, Ray, para habilitar RayTracing, técnica que melhora a qualidade das 
cenas geradas, você também encontra a percentagem do render final, 100, 75, 50 ou 
25%. A opção OSA, 5, 8, 11 e 16 lhe fornece uma suavização na imagem, chamada 
Antialiasing, imprescindível para criar boas imagens sem serrilhados. 
 
 
 
 
 
 
 
 
 
 
 
 
6.2.2 Janela Output 

Figura 93- Opções de saída para renderização. 

Figura 94- Opção para animação 

Figura 95- Janela Render 
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Na janela Output (Figura 96) você encontra, o diretório de saída para as imagens 
renderizadas em seqüência, geralmente o Blender usa uma pasta chamada //tmp ou 
c:\tmp. Em backbuff, você seleciona uma imagem de fundo para sua cena, basta clicar 
na pastinha e procurar a figura, e em Edge ainda é possível contornar sua imagem com 
uma linha, para passar a idéia de desenho animado (figura 98) ao seu trabalho final, 
onde, em Edge Settings, você encontra a espessura e a cor da sua linha (Figura 97).  
 

  

 
 
6.2.3 Gerando a saída 
 
Uma vez criada e ajustada a cena, de acordo com as opções acima, você poderá 
renderizá-la pressionando F12, após concluído o processo, pressione F3 na imagem 
gerada e escolha um diretório para salvar sua imagem final (Figura 99). 
 

 
6.3 Camadas 
 

O Blender utiliza o conceito de camadas para organizar seu trabalho, veja como utilizá-
los: 
 

Figura 96- Janela Output 

Figura 97- Espessura e cor da linha 
(Edge) na janela output 

Figura 98- Figura com aspecto de 
desenho manual 

F
igura 99- Acima ao lado do botão P você escolhe o diretório, e no campo inferior o nome do arquivo gerado, eu sugiro 
que use sempre PNG, para seu render. 
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1. Na 3d view, você verá um retângulo com 20 botões quadriculados(Figura 100), 

2. Selecione um objeto, no modo Object, pressione M e desloque-o para a camada 
desejada clicando no quadrado desejado (no exemplo, figura 101, camada 3). 

 
 
 
3. Para acessar o seu objeto transposto para a camada escolhida, utilize o painel inferior 
quadriculado, clicando na camada escolhida,  e você verá seu objeto. Se você segurar 
SHIFT enquanto clica nas camadas poderá ver muitas de uma vez só, e supondo que 
tenha vários objetos diferentes em cada camada, terá acesso a todos eles. 
 
6.4 Face Cut Loop 
 

O Face Cut loop é um corte que pode ser feito em um Mesh, no modo edit, para que 
você possa dividir sua forma e assim melhor moldá-la, seu atalho é CTRL+R(figura 102).  
 
Uma linha rosa surgirá no meio da forma, mexendo o mouse você localiza o corte e 
pressionando Entre o fixa (Figura 103). Antes de pressionar Enter, porém, é possível, 
aciona as teclas + e – do teclado numérico para aumentar a quantidade de cortes no 
objeto (Figura 104). 
 

Figura 100- Camadas do Blender 

Figura 101-Pressione M para deslocar o 
cubo para uma camada qualquer. 
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6.5 Knife 
 

A faca é outra ferramenta de edição, no modo Edit, você seleciona uma face um uma 
parte do Mesh, ou ele inteiro, e pressiona K, surgirá um menu com algumas opções: 
 

 
 

 Loop Cut- Já visto no último tópico 
 Knife (Exact)- Que te dá a opção de fazer um corte exatamente no ponto 

desejado. 
 Knife (Midpoints)- Esse corta a forma no ponto médio. 
 Knife (Multicut)- Corta a forma utilizando um número de cortes exatos 

especificados. 
Tabela 30 

 
Quando você tiver escolhido uma das opções, em geral se utiliza mais Knife (Exact), 
surgirá o ícone de uma faca, clique num ponto do mesh com o botão esquerdo , arraste 
o mouse (Figura 106)e fixe em outro ponto com ENTER. Seu corte estará feito.(Figura 
107) 
 

Figura 103-Após selecionar o local do 
corte, pressione ENTER 

Figura 104- Apertando "+" ou "-" você 
amplia a quantidade de cortes na face. 

Figura 105- Ferramenta Faca e seu menu de Edição. 
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6.6 Screw 
 

Recurso de rotação, muito útil para criar geometria específica, no caso, molas e espirais. 
O screw só funciona no modo edit e se localiza no sub-painel Editing>Mesh Tools. O 
screw funciona somente na vista ortogonal Front View (NumPad 1). 
 
Para criar o Screw você precisará de dois objetos: Uma linha que definirá a altura da 
mola e um quadrado que definirá a própria mola, abaixo o passo a passo: 
 
1. Vá para a visão frontal (Num Pad 1) e delete o cubo (X), (figura 108); 

 
 
2. Adicione um círculo de 8 lados ou mais(ADD>Mesh>Circle), depois, ainda no modo 
Edit, adicione outro de 4 lados, ambos sem preenchimento (Figura 109). 
 

 
3. Selecione dois Vértices do quadrado e apague com X ou Del, você agora tem uma 
linha e o polígono de 8 ou mais lados (Figura 110). 

Figura 106-Após aplicar a Faca (K), arraste 
o mouse. 

Figura 107- O corte estará feito após ser 
fixado com ENTER 

Figura 108 

Figura 109 
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4.O cursor 3d definirá o centro de rotação do Screw. Portanto atenção em sua 
localização. Se necessário aproxime mais o círculo da linha, para evitar uma mola muito 
larga (Figura 111). 
 

 
5. Em Editing > Mesh Tools, localize o botão Screw, uma vez encontrado escolha o 

número de voltas necessárias para sua espiral em Turns (Figura 112). 
 
6. Selecione todas as formas, ainda no modo Edit, com a tecla A. e pressione o botão 
Screw. 
7. Pronto, aí está sua mola (Figura 113). 
 

 

Figura 110 Figura 111 

Figura 112- Screw e número de voltas 
(Turns) 

Figura 113- Mola ou espiral elaborada 
com o Screw 
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8.Regulando a altura da Linha, você obtém uma mola com uma distância maior ou 
menor dos espirais. Exclua o cilindro interno para ter a mola puramente. 
 
6.7 Hide e Separate 
 

6.7.1 Hide 
 
Suponhamos que você esteja editando uma forma complexa (Figura 114), nesse caso o 
melhor a ser feito é ocultar uma parte não necessária, para que a outra possa ser vista 
com maior facilidade. Para isso, apenas selecione um objeto ou face, se estiver no modo 
edit, e pressione H, pronto, ele sumiu (Figura 115), Para tê-lo de volta, divida a janela do 
Blender, com a opção Split Area, e na nova janela selecione a Window Type>Outliner, 
essa janela é muito importante, pois através dela veremos todos os objetos da cena, 
procure o objeto com o olhinho fechado e abra-o (Figura 116), pronto, você acabou de 
revelar seu objeto oculto, ou então use o atalho ALT+H 
 

   

6.7.2 Separate 
 
No modo edit você seleciona uma face, por exemplo, ou várias, (use o Box Select-B), e 
pressiona P, um menu será aberto, então você escolhe Selected (Figura 117), quando 
voltar ao modo object, verificará que criou dois objetos distintos. Imagine que esteja 
modelando um boneco, e queira separar a cabeça do corpo, você seleciona as faces 
correspondentes a cabeça e pressiona P. Pronto, criou dois objetos distintos que não 
estarão mais no mesmo modo (Figura 118). 
 

Figura 114- No boneco a seguir 
ocultaremos a cebeça selecionada (H) 

Figura 115- Cabeça ocultada  
Figura 116- Através da janela 
outliner revelamos o objeto oculto 
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6.8 Spin e Spin Dup 
 

6.8.1 Spin 
 
Quando precisamos criar cantos arredondados e objetos cilíndricos em nossas formas, 
lançamos mão de um recurso chamado Spin, ele está no menu Mesh Tools próximo as 
Screw e só funciona no modo Edit. 
 
Para utilizá-lo você deve: 
 
1. Selecione o objeto e entre no modo edit (TAB) 
2. Supondo que ele seja o cubo padrão, vá para uma visão ortogonal, eu recomendo 
frontal (1), mas pode ser qualquer outra (Figura 119).  
 

 
 
3. Use o Box Select (B) e selecione os vértices superiores do lado direito (Figura 120),  
 

Figura 117- Selecione a parte que quer separar do corpo 
e pressione P 

Figura 118- Pronto! No modo Object você terá dois 
distintos objetos 

Figura 119- Vamos utilizar a 
visão frontal 1 para aplicar esse 
spin. 
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4. Agora use o menu Snap e escolha a opção cursor > selection, isso porque o Spin 
utiliza o cursor 3d para realizar suas curvas (Figura 121). 
 
 

 
5. Agora Selecione a face do lado direito (Figura 122). 

 
 
6. Vá para a opção Spin, no Mesh tools, e onde tem Degr selecione o ângulo de 
rotação de sua curva, você poderá usar ângulos negativos também, no meu caso utilizei 
-90º (Figura 123 ). 
 
 
7. Agora aperte Spin. Pronto você criou uma curva de 90º  
 

Figura 120 

Figura 121 

Figura 122 
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É possível criar ângulos mais abertos, para, por exemplo, modelar uma alça de uma 
xícara, apenas posicione o cursor 3d mais afastado do objeto, visto que o mesmo 
funciona como o centro do ângulo de rotação (Figura 125). 

 
6.8.2 Spin Dup 
 
Ao contrário do Spin, o SpinDup não cria cópias extrudadas, ele cria cópias reais e 
independentes, não ligadas por vértices ou faces, tirando isso, tem o mesmo método de 
utilização, sendo inclusive mais simples. Vamos elaborar um exemplo com spin dup: 
 
1. Utilizando o cubo inicial, ou outra forma qualquer, vá para a vista superior ( NumPad 
7), depois para o modo edit (TAB),(Figura 126).  
 

                                               
      

Figura 126 

Figura 123- O Spin é ideal para 
criar cantos arredondados 

Figura 124- Após a aplicação do Spin, temos nosso canto 

     
Figura 125- Mudando a posição do  
Cursor 3d, você tem curvas mais abertas 
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2. Selecione todas as faces conforme mostrado na figura 126, 
3. Posicione o cursor 3d no local onde você pretende que seja o centro de rotação do 
Spin Dup (Figura 127 ) 
 
 

 
4. No painel Edit > Mesh Tools, localize Spin Dup, mas não aperte-o, antes configure o 
número de cópias em steps (figura 128).  
 

 
 
5. Pronto. aplique o Spin Dup e veja o resultado. Na nossa cruz, tivemos um efeito de 
repetição interessante (Figura 129). 
 

 
 

Illustration 1: Figura 127 

Illustration 2: Figura 128- Spin Dup e 
número de passos Steps. 

Illustration 3: Figura 129- Esse tipo de efeito pode ser utilizado para a 
criação arquitetônica, por exemplo. 
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6.9 Lattices 
 

Lattices são extremamente comuns em softwares 3d, servem para deformar a malha, 
mais ou menos como se ela fosse emborrachada. Vejamos seu uso abaixo. 
 
1.Posicione o cursor 3d sobre o objeto que pretende deformar (Figura 130): 

 
 
2.Pressione Barra>add>lattice. Um cubo transparente é adicionado. Molde-o de modo 
que tome toda a dimensão do objeto (Figura 131). 
 
 
3. No painel Edit aparecerá a janela Lattice (Figura 132), Ela contém eixos U, V e W, 
que criarão os vértices de deformação,  

 
4. Ainda temos as opções (figura 132): 
 

 Lin (Linear) 
 Card (Cardinal) 
 B (B-Spline) 

 
São elas que definem a suavidade da deformação, sendo o B-Spline, a mais suave. 
 
5. Selecione o objeto (filho) e depois o Lattice (pai), agora pressione CTRL+P e 
selecione Lattice Deform. 
 

Figura 130 

Figura 131 
Figura 132- Os eixos U, V, W 
definem os vértices de deformação 
do lattice. 
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6. Selecione o Lattice e entre no modo Edit para deformá-lo, com as ferramentas 
anteriores (G, S, R etc.). Neste exemplo (Figura 133), deformei a figura do boneco, para 
algo mais cartunesco. 
 
6.10 Proportional 
 

A  ferramenta Proportional serve para aplicar deformações específicas no objeto, 
segundo sua área de influência. Funciona arrastando-se um vértice, ou um grupo, em 
determinado sentido. Mas para aplicá-lo é preciso, antes, ativá-lo. 
 
Você encontra o proportional ao lado dos botões de edição de vértice, edge e face. 
Clique no botão mostrado abaixo (Figura 135), e selecione On. As opções surgirão num 
menu chamado Falloff, conforme mostra o infográfico abaixo (Figura 136). 
 
 

 
 

Figura 133- Esse lattice tem valor 3 no 
U, V e W 

Figura 135- para desligar o proportional, escolha a 
opção Off. 

Illustration 4: Figura 136- Proportional e suas formas de utilização 

 
Figura 134- O lattice serve, dentre 
outras coisas, para criar 
deformações cartunescas. 
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6.11 Dupliverts 
 

Esta ferramenta localiza-se na janela Object>Anim Settings,  ela cria uma cópia do 
objeto “filho” em cada vértice do objeto “pai”. Desse modo, a quantidade de vértices do 
objeto pai, define os vértices do filho, abaixo você ver como a ferramenta de funciona 
(Figuras 137, 138, 139): 
 

   
Para utilizar o Dupliverts, siga os passos abaixo: 
1.Delete o cubo inicial 
2.Adicione um plano. 
3.Entre no modo edit e na janela Mesh Tools, no painel Edit, pressione o botão 
Subdivide (Figura 140), esta função subdivide o mesh (Figura 141). 
 

 
 

4.Volte para o modo object. 
5.Adicione uma esfera a sua cena e alinhe-a de modo que fique no centro do plano 
(Figura 142). 
 

 
6.Selecione a esfera (filha) e depois o plano (pai), pressione CTRL+P, para criar uma 
hierarquia. 
7.Vá para o painel Object>Anim Settings e selecione a opção Dupliverts (Figura 143 e 

Figura 137- Crie uma 
hierarquia. 

Figura 138-Subdivida o 
objeto pai. 

Figura 139- Aplique o 
Dupliverts 

Figura 140 
 

Figura 141- Mesh Subdividido em pedaços 
iguais 

Figura 142 
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144) 

  
8.Você pode criar variações interessantes e texturas para seus trabalhos utilizando 
esses conceitos. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 143 Figura 144- Dupliverts aplicado a esfera 
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7.1 Para que serve? 
 

sse menu é obtido pressionando-se a tecla W, quando seu objeto estiver no modo 
Edit. Serve especialmente, para aplicar modificações avançadas no seu mesh. No 
modo Object obtém-se booleans, que são operações geométricas realizadas 

entre objetos. 

 

 
7.2 Subdivide 
 

Coloque seu objeto no modo edit e selecione parte ou o mesh inteiro (Figura 146), ou 
parte dele, e pressione W, Escolha Subdivide e veja o resultado (Figura 147). Tome 
cuidado com a geometria triangular. 
 

  
7.3 Subdivide Multi 
 

Com esta ferramenta você seleciona a quantidade de divisões do mesh (Figura 148). 
Aplique-a no modo edit também, como a maioria das funções do menu Specials. A 
diferença é que com ela você especificará o número de subdivisões (Figura 149). 
 

E 

Figura 145- Menu Specials para funções avançadas 
do mesh. 

Figura 146 Figura 147 
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7.4 Subdivide Multifractal 
 

Cria subdivisões aleatórias no mesh, de modo que você poderá criar formas irregulares, 
como paralepípedos e cubos de gelo. Nesta ferramenta você precisa informar o valor 
aleatório da deformação, além, lógico, do número de subdivisões. Quanto maior, mais 
deformado ficará o mesh (Figura 150). 

 
7.5 Subdivide Smooth 
 

Neste caso a subdivisão arredonda a forma dando-lhe uma aparência mais suave, 
porém também deformada. Muito útil para criar cabeças de cartoon (Figura 152). 
 

 

 
7.6 Merge 
 

Figura 148 Figura 149 

Figura 150- Objeto deformado 
com o modo Subdivide Multifractal 

Figura 151 Figura 152- O cubo deformado 
assume uma aparência perfeita 
para a modelagem de cabeças 
humanas. 
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Com esta ferramenta você une dois elementos (Figura 153), ou mais, mesclando-os em 
um só(figura 154). Selecione dois vértices de um objeto, por exemplo, pressione W e 
escolha merge. Um menu surgirá perguntando-lhe se você deseja mesclar os pontos ao 
centro (At Center), (Figura 154) ou a opção ao cursor,(At Cursor), (Figura 155). Nesse 
último caso, o cursor 3d funcionará como ponto das transformações. Ainda é possível 
selecionar outras opções, treine-as individualmente(Figura 156). 
 

   

 
7.7 Remove Doubles 
 

Com esta ferramenta removemos os pontos sobrepostos de nossa modelagem, ela é 
necessária porque quando modelamos algo, muitas vezes obtemos pontos sobrepostos 
que atrapalham a renderização. Para utilizá-la, no modo Edit, pressione W  e depois 
Remove Doubles. O Blender calculará a quantidade de pontos que devem ser 
removidos, otimizando sua modelagem (Figura 157). Quanto mais pontos forem 
removidos mais suja estava sua modelagem e mais limpa ficará. 
 

 
 

Figura 153 Figura 154 Figura 155 

Figura 157- Remove doubles é uma 
ferramenta importantíssima, para uma 
boa modelagem 

Figura 156 
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7.8 Hide 
 

Com o hide ocultamos parte de um objeto, ou ele inteiro (Figura 158), que não nos é 
interessante no momento (Figura 159), seu funcionamento é análogo ao hide visto 
anteriormente. Porém sua forma de utilização se processa através do menu W 
(Specials).  
 

  
7.9 Reveal 
 

Esta ferramenta possibilita que revelemos a forma anteriormente oculta. Veja o que 
acontece com o objeto anterior (Figura 160). 
 

 
 
7.10 Select Swap 
 

Imagine que você queira selecionar um todo excluindo uma parte (figura 1). Isso é muito 
comum quando você necessita trabalhar em uma grande seleção, mas deseja excluir 
uma parte pequena dela. Nesse caso, o melhor mesmo é utilizar o Swap, que faz uma 
seleção inversa. 
 

Figura 158 Figura 159- Parte do objeto ocultada 

Figura 160- O objeto que estava oculto, foi agora 
revelado. 
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7.11 Flip Normal 
 

Todo objeto possui faces chamadas Normais ou Normals, que são as partes visíveis 
dele, as que recebem todo o tratamento de luz e textura (Figura 163). Ocorre que as 
vezes sua modelagem fica com as normais invertidas, o que acarreta falhas na 
renderização, nesse caso é preciso ajeitá-las. O que esta ferramenta faz é inverter as 
normais das faces escolhidas, assim você poderá deixá-las do lado certo. Para ver as 
normais de um objeto, para que lado estão, vá para menu  Mesh Tools 1, no menu Edit, 
e selecione Draw Normals ( Figura 164). 
 

 
 

7.12 Smooth  
 

Esta ferramenta suaviza o mesh (Figura 165), ou parte dele, puxando os vértices para o 
centro geométrico do objeto, o resultado pode ser bom ou uma deformação indesejada. 
 
 

Figura 161- Selecione a parte que não 
quer... 

Figura 162- Aplique um Swap e a 
inversão estará feita. 

Figura 163- Normais 
desenhadas para o lado de 
fora do objeto. 

Figura 164- Normais podem ser 
exibidas através do menu Mesh Tools 
1, para desativá-las, clique de novo no 
botão. 
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7.13 Bevel 
 

Cria um chanfro (Figura 166) numa forma geométrica, dando a aparência de uma forma 
arredondada (Figura 167). Você escolhe a resolução do arredondamento, arrasta o 
mouse e fixa com o clique. 
 

  

7.14 Set Smooth 
 

Esta ferramenta cria uma maquiagem, entre as arestas de uma forma, tirando o efeito 
quadriculado de um mesh, ou reduzindo-o (Figuras 168 e 169), ela será especialmente 
útil, quando estivermos lidando com os modificadores, ou quando trabalhamos com 
formas mais arredondadas, você pode aplicá-la em parte, ou em todo o objeto. 
 

  

 
Figura 166- No modo edit você 
acessa o menu Specials e aplica o 
Bevel 

 
Figura 167- Objeto após a 
aplicação do Bevel 

Figura 168- Uma esfera sem o Set 
Smooth 

Figura 169- Esfera com a aplicação de 
suavização Set Smooth 

Figura 165- Muitas vezes a 
impressão que temos é que o 
objeto apenas sofreu uma redução 
após o Smooth, o que de fato 
ocorre também, porém ele sofre 
uma simplificação geométrica. 
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7.14.1 Set Solid 
 
Ao contrário do Set Smooth, o Set Solid tira a suavização de uma forma, ou parte dela. 
Ele é muito útil quando você necessita aplicar uma suavização em apenas parte de um 
objeto. 
 

 

 
 
 
7.15.Modificador Subsurf: Nova vida para suas 
modelagens. 
 

7.15.1 Uso Básico 
 
Modificadores são ferramentas que adicionam efeitos especiais a sua malha, 
futuramente abordaremos os mesmos com mais eficiência, por hora cabemos, devido a 
sua grande similaridade com as ferramentas do Menu Specials (W) aprender a utilizar o 
modificador Subsurf. Esse modificador suaviza a malha, aplicando sucessivas 
subdivisões, ao contrário do set smooth, que cria uma maquiagem nos vértices. Ele é 
fundamental para a quase totalidade das atividades de modelagem orgânica, ou com 
formas orgânicas. Abaixo veja uma cadeira modelada sem subsurf e outra com subsurf 
(Figuras 172 e 173). Sua função também é converter ângulos agudos em curvas 
suavizadas, o que nem sempre é interessante. 
 

 
 

Figura 170- Objeto sem set smooth ou 
set solid 

Figura 171- Selecionamos metade da 
forma com o Box Select e aplicamos o 
Set Smooth de um lado e do outro o 
Set Solid 

Figura 172- Malha sem o subsurf Figura 173- Modificador subsurf aplicado a 
malha. 
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O subsurf tem dois modos de operação. O primeiro chama-se Simple Subdivision, e 
apenas subdivide a malha, sem aplicar suavização a mesma. O segundo, Catmull-
Clark, subdivide e suaviza de fato toda a extensão do objeto, ele é o mais utilizado, sem 
dúvida. Ambos estão localizados no Painel Edit > Modifiers > Add Modifier > Subsurf 
(figura 174). Basta selecionar o objeto e aplicá-lo seguindo o caminho ensinado. 
 

 
Ainda na figura acima, temos o Levels que define o nível de suavização visto na 3d view, 
o Render Levels, definidor da suavização na renderização, o Optimal Draw, que otimiza 
a renderização dos segmentos internos e o Subsurf UV, responsável pela suavização 
das texturas, que veremos adiante. 
 

 
Os três botões ao lado do campo Subsurf (Figura 175), ainda definem se o modificador 
será habilitado durante a renderização, se será visto na área de trabalho e se será visto 
no modo edit, respectivamente. O botão X cancela o modificador, enquanto o Apply 
aplica-o no objeto definitivamente. 
 
Importante: Tenha em mente que ao usar o subsurf, você deverá utilizar levels baixos, 
do contrário sua modelagem ficará muito pesada. 
 
7.15.2 Opções avançadas 
 
Ao aplicarmos o subsurf em um cubo, por exemplo, podemos ter uma forma 
excessivamente curvilínea, para resolver este problema aplicamos um Face Cut Loop 
(CTRL+R) na superfície em que se deseja criar ângulos mais agudos. No exemplo 
abaixo (Figuras 176 a 179), fizemos um tambor facilmente. 
 

Figura 174- Catmull clark e Simple 
Subdiv.  

Figura 175 
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Ainda é possível utilizar o Edge Sharpness, onde você seleciona uma aresta qualquer, 
ou várias, e pressione SHIFT+E, após isso, arrasta o mouse e fixa com o clique do botão 
esquerdo (Figura 180), assim você consegue outro ângulo agudo. 
 

 
 
 

 
 
 

Figura 176- Vamos criar um 
tambor com passos simples a partir 
do cubo inicial... 

Figura 177- No painel 
Edit>Modifiers> Adicionamos um 
Subsurf de valor 2 nos dois campos, 
como visto acima. 

Figura 178- Seu cubo ficará assim. 

Fi
gura 179- Adicione o Face Cut Loop 
no modo edit e arraste o mouse para 
cima até obter a forma aguda 
necessária para o tambor. 

Figura 180 Note o ângulo agudo sendo formado no 
ponto da linha serrilhada 



 83 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
CAPÍTULO VIII__________________________________________________________ 
 



 84 

8.1 Agora... 
 

ue aprendemos os princípios básicos da modelagem por subdivisão, aquela em 
que a forma é subdividida até nos dá o objeto desejado, algo bem próximo do 
que acontece na modelagem manual, partiremos para os exercícios práticos, que 

visam adestrar seu conhecimento, de modo a deixar sua mente e habilidades 
suficientemente afiados para a lide diária. Os conceitos aprendidos com esses 
exercícios podem ser replicados em outros. Os níveis de dificuldade variam do mais 
elementar ao mais difícil, sem que necessariamente seja impossível lidar com o último, 
pelo contrário, o objetivo da ferramenta é ser de fácil assimilação por parte do usuário 
final. Então, vamos lá? 
 
 
8.2 Modelagem de um frasco de perfume 
 

Criaremos o frasco de perfume mostrado abaixo (Figura 181). Esse tipo básico de 
modelagem é bastante útil para design de produto, onde a simplicidade é o norte. Por 
isso, com metodologias simples, você poderá conseguir excelentes resultados. 
 

 
1. Aproveite o cubo inicial do Blender e vá para a visão da câmera (Figura 182), (Num 
Pad 0).  
 

 
2. Escalone-o no eixo Y, até obter uma forma retangular, que será o corpo de nosso 

Q 

Figura 181- Modelaremos este frasco a partir de 
agora 

Figura 182- Visão da câmera NumPad 0 
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perfume, conforme a figura 183 (Pressione S, depois Y e mova o mouse até  obter a 
forma desejada, fixe com o clique do botão esquerdo). 
 

 
 
3.Na janela Link and Materials no Painel Editing (Editing > Link and Materials) No 
campo ME e OB coloque respectivamente o nome “perfume”, ou outro que preferir, com 
isso estaremos dando nome aos nossos bois (Figura 184). É sempre importante que em 
nossos trabalhos de modelagem façamos isso: Nomear os objetos da cena. 
 

 
4. Se quiser subdividir a área de trabalho, use a função Split Area, onde você clica na 
borda das janelas com o botão direito e escolhe-a. Isso pode ser útil, caso queira utilizar 
várias vistas para sua modelagem, como no 3D Studio Max (Figura 185). 
 

 
5.Entre no modo Edit(TAB) e selecione a face superior do cubo com box select (B) ou 

Figura 183- Objeto escalonado no eixo Y 

Figura 184-Nomeie o objeto da cena 

Figura 185-Área de trabalho subdividida para acoplar várias vistas 
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com  botão direito do mouse no modo face Figura (186). 
 

 
 
6.Agora vá para a visão frontal (NumPad 1) e escalone o valor de 0.8. Pressione S 
(scale),  e digite o número “0.8”, finalize com ENTER (Figura 187). Mantenha a face 
superior ainda selecionada, se necessário use o menu SNAP para centralizar o cursor 
3d (Shift+S) na seleção. 
 

 
7.Volte para a visão da câmera e rotacione a face no eixo Z uns 20 Graus. Pressione 
Numpad 0, R (rotate), Z (eixo) e depois digite o número 20, fixe com ENTER (Figura 
188). 
 

 
8. A essa altura já temos o básico de nosso frasco, vamos criar a tampa: Pressione A 
duas vezes, para selecionar toda a forma, e faça um Face Cut Loop (CTRL+R), onde 
iremos criar duas divisões no corpo da  malha, pressione a tecla “+” do NumPad após o 
CTRL+R e isso ocorrerá facilmente. Fixe com ENTER (Figura 189). 
 

Figura 186- Selecione a face 
superior com o B. direito do mouse 

Figura 187-Objeto escalonado no topo 

Figura 188- Objeto rotacionado no topo. 
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9.Agora iremos aplicar dois Face Cut Loop no topo do Mesh, aplique o primeiro e arraste 
para um lado e depois o segundo e faça-o para o outro. O resultado deve ser um 
pequeno quadrado no centro que será a tampa (Figura 190). 
 

 
10.Selecione esse pequeno quadrado, e extrude-o com a tecla E, de modo que fique 
semelhante a figura abaixo. Pronto você terá a tampa (Figuras 191 e 192). 
 

  
11.Agora vamos criar uma reentrância no corpo do frasco, selecione as faces de um dos 
lados, com o Botão Direito do Mouse e a tecla SHIFT, e após extrude-as  no modo 
Region, pressione ESC, porque queremos apenas uma sobreposição de faces (Figura 
193). 
 

Figura 189- Face Cut Loop e tecla "+" 
para adicionar uma subdivisão extra. 

Figura 190- Note a geometria do 
nosso mesh e o quadrado no centro. 

Figura 191 Figura 192- Extrusão aplicada 
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12.Escalone-as (S de Scale), puxando o mouse para o centro, do modo como visto 
abaixo (Figura 194). 
 

 
13.Extrude de novo, no modo Region, agora puxe o mouse para dentro com o Gizmo, de 
modo a criar um relevo negativo, como pode ser visto na figura abaixo, se sua extrusão 
ficar torta ajeite-a com a movimentação do Gizmo, ou com o Grab (G) (Figura 195). 
 

 
14.Saia do modo Edit e adicione um plano para sua cena, na vista superior, NumPad 7, 
(Add>Mesh>plane).Ajuste-o conforme figura abaixo (Figura 196). 
 

Figura 193- Ao extrudar o objeto e pressionar 
ESC você apenas sobrepõe as faces. 

Figura 194- S e arraste a guia para o centro. 
As faces sobrepostas são escalonadas em 
direção ao centro do objeto. 

Figura 195- O relevo negativo é criado com 
uma extrusão interna. 
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15.Se quiser aplique um modificador subsurf no seu frasco, ou um Set Smooth 
(Editing>Link and Materials>Set  Smooth).Cuidado com o Subsurf, é preciso aplicá-lo 
com o Edge Sharpness ou então com o Face Cut Loop, do contrário sua modelagem 
ficará deformada(Figura 197). 
 

  
16. Posicione a câmera no melhor ângulo, ou pressione CTRL+ALT+0, isso fará a sua 
visão se transformar na da câmera (Figura 199). 
 

 
17. Coloque sua lâmpada entre a câmera e o objeto, para ter uma boa iluminação 
(Figura 200). 
 

Figura 196- O plano servirá para compor a 
cena e gerar sombras projetadas. 

Figura 197- Objeto deformado pela má 
aplicação do Subsurf 

Figura 198- Objeto com Set Smooth 
aplicado 

Figura 199- Visão da Câmera aplicada ao 
objeto 
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18. Salve seu trabalho, antes de renderizar a cena (File>Save), lembre-se que seu 
arquivo deverá chamar-se “algumacoisa.blend” por conveniência, chamaremos de 
frasco.blend (Figura 201). 
 
 

 
19. Pressione F12 para renderizá-lo e após, F3 na janela de saída da imagem, para 
salvá-lo como JPG, TGA ou PNG. 
 
20. Se necessário adicione outra Lâmpada a cena, com o atalho Menu 
Add>Lamp>Lamp, faça isso se sua renderização ficar muito escura (Figura 202). 
Existem outros tipos de lâmpadas, que veremos posteriormente. Veja na figura 203, 
como ficou o resultado final. 
 

Figura 200- A lâmpada é o objeto 
redondo na lateral direita. 

Figura 201- Nesta tela você salva seu arquivo Blend. Lembre-se: O P sobre a 
raiz do diretório 
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8.3 Modelagem de uma cadeira. 
 

Vejamos agora o passo a passo para criar uma cadeira utilizando extrusão orgânica: 
 
1.Utilizando o cubo inicial do Blender, entre no modo edit (TAB), e delete o mesh inteiro 
(X) ou Del, selecione-o com A, antes (Figuras 204 e 205). 
 

 

 
2.Vá para a visão frontal (1), ainda no Edit Mode, lembre-se, que, embora a malha esteja 
ausente a instância do objeto existe (Figura 206). 

Figura 202- Com uma única lâmpada o objeto ficou 
excessivamente escuro... 

Figura 203 ...Porém com outra lâmpada por detrás a 
cena ficou bem mais atraente 

Figura 204 Figura 205-Apesar de ausente a 
instância do objeto ainda existe,o 
que pode ser percebido pela 
presença do ponto róseo no meio 
da tela. 

Figura 206- Visão frontal na 
visualização em perspectiva 
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3.Acione a visão ortogonal, pressionando NumPad 5 (Figura 207). 
 

 
4.Em algum ponto da 3D view pressione CTRL+Botão Esquerdo do Mouse, Você 
acabou de criar um ponto, entre agora no modo vértice (Figura 208). 
 

 
5.Clique em outro ponto com o CTRL, você acabou de criar um segmento de reta 
(Figura 209). 
 

 
6.Agora repita o processo de desenho, até obter o contorno de nossa cadeira (Figura 
210). 
 

Figura 207 

Figura 208- Vértice criado servirá de 
"pivô" para nossa modelagem 

Figura 209- Segmento de reta 
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7.Saia da visão ortogonal (NumPad 5) e ponha uma vista aleatória mais confortável 
(Figura 211). 
 

 
8.Selecione todos os vértices com A (Figura 212) e extrude-os no eixo Y, essa extrusão 
é do tipo Only Edges (Aperte E, depois Y e arraste o mouse, fixando com o clique do 
botão esquerdo), de acordo como mostra a figura 213. 
 

  
9.Agora selecione todos os vértices e extrude no eixo Z, essa extrusão é do tipo Region 
( E, Z, arraste o mouse e fixe com o clique), façamos isto para obter a espessura da 
cadeira. 
 

Figura 210- O esqueleto de nossa cadeira 
está aí. 

Figura 211 

Figura 212- A uma ou duas vezes para 
selecionar todos os vértices 

Figura 213- Após a extrusão, os edges 
formaram as faces. 
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10.Agora selecione tudo com A, ou A duas vezes, aplique um Face Cut Loop, para 
dividir nossa malha ao meio, conforme abaixo na figura 215. 
 

 
11.Se quiser, selecione a visão frontal ou lateral e faça um box select (B) no encosto da 
cadeira, para um tratamento mais refinado com Grab (G), o famoso pucha-estica. Faça 
algo semelhante na parte inferior da cadeira (Figura 216). 
 

 
 
 
 
 
 
 

Figura 214- a Extrusão no eixo X define a 
espessura da cadeira 

Figura 215- Cadeira dividida ao meio com um 
Face Cut Loop 

Figura 216- Refinamento na modelagem 
utilizando o grab (G) ou o Scale (S) 
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12.Ok, vá para a visão ortogonal onde você encontrará sua cadeira de frente, e 
selecione todo o eixo do meio conforme figura 217. 
 

 
 
13.Agora utilizando o Proportional>Sphere Falloff, puxe o encosto um pouco para trás, 
de modo que criaremos uma forma anatômica (Figura 218), depois desligue o 
proportional, em Proportional>Off. 
 

 
14.Vá para o modo Object e aplique um modificador Subsurf (Editing>Modifiers>Add 
Modifier>Subsurf), veja que ele suavizou demais nossa malha. 
 

 
 

Figura 217 

Figura 218- O proportional foi utilizado para 
suavizar o encosto da cadeira. 

Figura 219- O subsurf cria formas muito 
orgânicas 
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15.Entre no modo Edit novamente, e aplique o Face Cut Loop (CTRL+R), no topo e na 
base para deixar os ângulos mais agudos, arraste-os até o canto (Figura 220). 
 

 
16.Vamos para a criação dos braços.Volte para o modo object e ponha sua cadeira na 
vista superior (7), posicione o cursor 3D, ao lado  da cadeira (Figura 221). 
 
17.Adicione um círculo com 16 vértices e raio de 1, (Add>Mesh> Circle ou use a Barra 
de espaço) (Figura 222) 
 
18.Reduza esse círculo de modo que fique compatível com o que se pode esperar da 
espessura do braço tubular de uma cadeira (S de Scale e movimente o mouse, clique 
para fixar). 
 

  
19.Vá para a visão lateral e faça um alinhamento básico da base do braço com o corpo 
da cadeira, utilizando nossas já conhecidas funções de arrasto, Grab (G) (Figura 223). 
 

 

Figura 220- Uma vez que você aplica o 
Face Cut Loop no subsurf seu objeto retoma 
a forma mais geométrica 

Figura 221- vista superior com 
Cursor 3d ao lado da cadeira 

Figura 222- Circunferência 
adicionada com 16 vértices 

Figura 223- Aqui você percebe o círculo, já 
redimensionado, ao lado da cadeira. 
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20.Extrude o círculo previamente selecionado no modo Only Edges e no eixo Z, 
obteremos assim um tubo. 
 

 
21.Selecione-o Inteiro e arraste para um região mais próxima de onde estaria o braço de 
nosso usuário (Figura 225.) 

 
 
22.Vamos aplicar um Spin para obter a dobra do braço perfeita, e assim prosseguir com 
nossa modelagem.Vá para uma vista mais confortável, selecione o vértice mostrado na 
figura abaixo (Figura 226), pressione SHIFT+S, e escolha Cursor To Selection, volte 
para a vista lateral e faça um box Select nos vértices superiores que formam o anel 
(Figura 227), então aplique um Spin de 90º (Figura 228). 
 

  
 

 
 
 
 

Figura 224- Extrusão aplicada ao Círculo no 
modo Only Edges nos deus um tubo 

Figura 225 

Figura 226- Vértice que será o centro 
do Spin 

Figura 227- O Box Select pegará 
todos os vértices que aparecerem por 
trás e pela frente 

Figura 228-Spin de 90º para a sua 
curva perfeita 
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23.Extrude a extremidade até obter o formato abaixo (Figura 229). 
 

 
25.Aplique outro Spin, para obter a curva descendente vista abaixo (Figura 230). 
 

 
26.Extrude até o solo (Figura 231). 
 

 
27.Vá para a visão traseira (Figura 232) e aplique outro Spin, vamos fazer a curva da 
base da cadeira dos dois lados de uma vez só, visto que ao aplicarmos na parte traseira 
um box select, a parte frontal também é selecionada,então faça tudo como se estivesse 
na visão detrás, visto que a frontal também sofrerá as mudanças (Figura 233): 
 

Figura 229- A extrusão após o spin 
confirma os nossos propósitos 

Figura 230-Mais um Spin, este para 
modelar a parte detrás do suporte da 
cadeira 

Figura 231- Mais uma curva e outra 
extrusão 



 99 

 
 

28.Extrude até a metade no eixo Y, ou outro, o resultado pode ser visto abaixo (Figura 
234): 
 

 
29.Pronto. já temos o suporte básico, vamos então duplicá-lo, certo? Volte para o modo 
Object, vá para a vista frontal da cadeira, e com o braço selecionado, aperte SHIFT+D, 
para duplicá-lo. 
 
30.Pressione CTRL+M para espelhar o braço no eixo correspondente e assim obter a 
nossa forma final (Figura 235). Ajeite um pouco, com o Grab (G) caso seja preciso. Você 
terá o braço da cadeira inteiro agora (Figura 236). 

Figura 232- Ao aplicarmos  um box select 
na parte de detrás, a parte frontal também 
é selecionada, e isso diminuiŕa nosso 
trabalho de modelagem 

Figura 233- Outro Spin aplicado, a parte 
frontal por estar no mesmo eixo, também 
sofreu a modificação. 

Figura 234-Após muitos spins e extrusões, nosso 
trabalho aproxima-se do fim 

 
Figura 235- Após aplicar um mirror, 
economizamos o trabalho de modelar o outro 
lado da cadeira 

 
Figura 236- Nosso trabalho está quase 
pronto, vamos só aplicar um acabamento 
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31.Adicione um plano usando a vista superior (7), para servir de piso (Figura 237). 
 
32.Escolha um bom ângulo com as teclas de movimentação da área de trabalho e 
pressione CTRL+ALT+0, para focar a câmera, ajuste as luzes, colocando mais uma ou 
duas Lamps (Add>Lamp>Lamp) 
 
33.Salve a modelagem 
 
34.Renderize a cena e salve com F3 (Figura 238) 
 

 

 
8.4 Modelagem de uma taça  
 

Existem duas formas de se modelar objetos circulares. Uma é por meio de sucessivas 
extrusões e outra, mais inteligente, por meio do Spin. Pelo método do Spin, vamos criar 
um sólido de revolução. 
 
1.Utilizamos o cubo inicial do blender e  
entramos no modo edit (TAB), nele deletamos o cubo selecionando-o todo por meio da 
tecla A, e  
apertando X, ou Del. Bom, a instância da forma ainda está lá, mas a forma sumiu 
(Figura 239): 

Fgura 237- Piso adicionado para compor a cena 

Figura 238- Cadeira renderizada. É possível aplicar um 
Set Smooth ou aumentar o subsurf para retirar esse efeito 
meio quadriculado. 

Figura 239- Objeto no modo Edit com 
sua instância apenas. 
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2.Vamos criar a silhueta de uma meia taça, então: Aperte CTRL+Botão Esquerdo do 
mouse na vista Ortogonal Direita (NumPad 3.), veja que você acabou de colocar um 
ponto, dois dão uma reta, certo (Figura 240)? Clique mais uma vez com o CTRL e terás 
a reta. Repita o procedimento até modelar metade da taça, conforme mostra a figura 
abaixo (Figura 241):  
 

 

 
3.Agora selecione o vértice mais inferior possível, na direita de baixo e utilize o menu 
Snap, então  
escolha Cursor> Selection . Pronto. Com isso definimos o eixo de rotação.  
 

 
 
4.Agora vamos para a revolução, indo para a vista superior (Num Pad 7) (Figura 243), 
selecione todos os vértices com a tecla A duas vezes. No painel Editing, >Mesh Tools 
(Figura 244), clique no botão Spin, quatro vezes e voilá, terás a tua taça (Figuras 245 e 
246).  

Figura 240- Dois pontos unidos nos dão uma 
reta, obtida em Edit no modo Vertex. 

Figura 241- A silhueta de 
nossa taça está aí, montada 
após sucessivas extrusões. 

Figura 242- Selecionamos a parte  
inferior com o Snap e assim 
criamos o eixo de rotação 
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5.Volte então para o modo objeto apertando outra vez a tecla TAB e depois o Zero do 
teclado  
numérico, para ter a visão da câmera. Veja que a taça ficou meio quadriculada, isso 
devido a utilização de poucas subdivisões no mesh, vamos corrigir isso aplicando o 
Subsurf. Mas antes iremos retirar vértices sobrepostos que atrapalham na renderização 
do objeto. Entre no modo de edição e aperte W> Remove Doubles. Pronto!  
 
6. Volte para o modo object e aplique o modificador subsurf presente em 
Editing>Modifiers. Selecione Add Modifier e Suburf. Perceba que o Blender alisou a 
malha, porém, não tanto, pois se você aumentar o nível do modificador, deixará sua 
máquina lenta. Por isso você deverá usar em conjunto com o Subsurf o Set Smooth 
presente na janelinha Link and Materials. Esta função alisa a junção entre as malhas 
resolvendo a imagem quadriculada indesejada. Aproveite que está na janela Link and 
Materials e Nomeie o objeto nos Campos OB e ME como taca. 
 
7. Componha a cena com um plano e salve-a. Ou ainda procure um bom ângulo, 
pressione CTRL+ALT+0 e renderize-a. Atenção para a iluminação, coloque várias 
lâmpadas, antes de finalizar o processo, assim você terá uma cena bem iluminada sem 
sombras profundas.Uma dica é ir para a vista superior (Num Pad 7) e duplicar as 
lâmpadas com SHIFT+D, fica bem mais fácil (Figura 247) 
 

Figura 243- Selecione todos os 
vértices... 

Figura 244- ...E na janela Mesh Tools 
escolha a opção Spin 4 vezes. 

Figura 245- Taça em vista superior 

Figura 246- Taça em escorço 
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Utilize o mesmo princípio do sólido de revolução para a modelagem de frutas, garrafas, 
vasos tigelas, copos etc. 
 

 

 

 
8.5 Modelagem de uma caneca. 
 

Muito simples, vamos modelar um copo por extrusão e subdivisão. Uma técnica 
diferente da anterior, com ela você poderá elaborar embalagens diversas, latas, frascos 
etc.Portanto, tanto a modelagem por revolução, quanto a por subdivisão são 
importantíssimas. 
 
1.Exclua o cubo inicial (Selecione-o e X ou Del) do Blender e vá para a vista superior, 
(NumPad 7). 
 
2.Adicione um círculo de 8 segmentos ( Add>Mesh>Circle ou barra de espaço )  
(Figura 252). 

 
Figura 247- Cena em vista superior com 
várias lâmpadas duplicadas. 

 
Figura 248- Cena renderizada 

Figura 249- Tanto esta fruteira como 
suas maçãs foram modeladas por 
revolução, portanto você também 
poderá fazê-las, desde já. 

Figura 250- Um copo mais bruto, 
modelado por extrusão e revolução 

Figura 251- Esta jarra foi um dos 
meus inúmeros exercícios, ela está 
presente no Blender- Guia do Usuário 
de Allan Brito, ela pode ser 
conseguida por revolução, porém 
precisará de ajustes no final 

 
Figura 252- O "círculo" não pode ser 
 preenchido 
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3.Entre no modo edit (TAB), e acione o modo de seleção Edge. 
 
4.Agora selecione todos os segmentos e aperte E, para realizar uma extrusão, pressione 
ESC porque nossa extrusão não será de deslocamento. 
 
5.Agora aperte S (Scale) e puxe os segmentos extrudados para o centro (conforme a 
figura  253) arrastando o mouse, fixe com o clique do botão esquerdo. 
 

 
6.Extrude de novo e pressione ESC outra vez. 
 
7.Escalone (S) sem mexer o mouse e logo após digite “0”,você escalonou sua forma 
para o ponto de origem (Figura 254). 
 

 
8.Agora coloque seu mesh numa vista mais confortável, selecione tudo com A duas 
vezes e faça uma extrusão sutil, do tipo region, no eixo Z (Figura 255). 

Figura 253- Após uma extrusão um 
escalonamento em direção ao centro 

Figura 254- Após a extrusão uma escala 
para o próprio centro 

Figura 255- Com essa extrusão 
compomos a base de nossa caneca 
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9.Agora selecione as faces externas superiores (Figura 256), e extrude um pouco 
(Figura 257). Eu recomendo que a partir de agora você use a vista ortogonal  frontal 
(Numpad 1) 
 

  
10.Agora escalone, só que desta vez, puxe sua malha para for a (Figura 258). 
 

 
11.Extrude mais duas vezes até obter uma forma como a mostrada na figura abaixo 
(Figura 259). 
 

 
12.Saia da visão ortogonal frontal e vá para a superior (7) Tente alinhar a face escolhida 
para ser a pega de sua caneca (Figura 260) perpendicularmente ao eixo X, faça isso 
selecionando tudo com A, e aplicando um rotate (R) no eixo Z, você controla a rotação 
com o mouse e fixa com o clique do botão esquerdo (Figura 261). 
 

Figura 256-Faces externas selecionadas... Figura 257...e extrudadas 

Figura 258- Após a extrusão escalone a 
borda de sua caneca para fora (S e puxe o 
mouse). 

Figura 259- Após algumas extrusões, nossa 
caneca começa a tomar forma 
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13.Saia da visão ortogonal, selecione a face onde você colocará  a alça e aplique 
sucessivos faces cut loop (CTRL+R) até obter cortes como os mostrados abaixo. 
 

 
14.Selecione o pequeno quadrado mostrado na figura abaixo (Figura 263) e extrude-o 
no eixo X , escalone-o um pouco em direção ao centro para diminuir a espessura da 
pega de nossa xícara (Figura 264). 
 

  
 
 
 

Figura 260- Essa face deve ficar 
perpendicular ao eixo X, isso é 
necessário para que o Spin seja 
corretamente aplicado. 

Figura 261- Pronto! a face de nossa pega 
está perfeitamente alinhada com o eixo X. 

Figura 262- Esses cortes são obtidos com o 
Face Cut Loop. 

Figura 263-Esse pequeno quadrado 
constituirá a raiz da asa de nossa caneca 

Figura 264- Extrusão com 
escalonamento (S) em direção ao centro 
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15.Agora vá para a visão frontal, ainda com a face selecionada, e posicione o cursor 3D 
no local mostrado na figura abaixo. Será o centro do nosso spin (Figura 265). 
 
 

 
16.Aplique dois spins (Editing>Mesh Tools>Spin) e veja o resultado: Criamos uma 
pega para nossa caneca (Figura 266). 
 

 
17.Selecione as bordas internas da mesma, como mostra a figura abaixo (Figura 267), 
com o Vertex Loop (ALT+Clique com o botão direito do mouse no anel que deseja 
selecionar), no modo Edge, e escalone (S em direção ao exterior), no sentido de afinar 
as bordas de nossa caneca, que estão muito grossas (Figura 268). 
 

  

Figura 265- O cursor 3d mostra o centro do 
Spin, o arco usa-o como medida de rotação 

Figura 266- A pega foi conseguida com 2 
spins de 90º 

Figura 267- As bordas estão muito 
grossas... 

Figura 268- Afinamos, então com 
um escalonamento esterno (S e puxe 
o mouse para o lado de fora) 
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18.Agora aplique um subsurf de Level 2, (Editing>Modifiers>Add Modifier>Subsurf) 
e aplique o Set Smooth presente no painel Link and materials, e já que você está nele, 
nomeie seu objeto como “caneca” nos campos OB e ME . 
 

 
19.Pronto, componha a cena com um plano, ou algo que lembre uma mesa (Figura 270), 
ache um bom ângulo utilizando os atalhos já vistos da 3d view, focalize a câmera 
(CTRL+ALT+0) (Figura 271), adicione umas luzes e renderize com F12 (Figura 272), 
porém antes salve seu arquivo. 
 

 
 

  
 

Figura 269- Objeto após a aplicação 
do Subsurf e Set Smooth 

Figura 270- Na vista superior (NumPad 
7)você terá maior facilidade em adicionar 
novas luzes, uma boa idéia é a formação 
triangular, muito boa para design de 
produto. 

Figura 271- Um bom ângulo de câmera é 
fundamental para tornar seu trabalho 
atraente. 

 
Figura 272- 3 luzes podem dá um aspecto lustroso  
ao seu projeto, pois gerarão muita reflexão. 


